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AN INTRODUCTION TO
KINDWORDS

This chapter is a short introduction to KindWords: how to
open KindWords, getting familiar with the KindWords
screen, and how to quit KindWords. If you've never used a
word processor before, read through the manual carefully with
an Amiga beside you.

Before starting, copy the serial number as it appears on your
warranty card here for future reference:

Making a Backup Disk of KindWords

We recommend you make backup copies of your three
KindWords disks before using the program. If you are not
familiar with how to copy disks, we suggest you consult the
Amiga Users Guide.

Note: You must rename your copies to the original name. That is,
rename "Copy of KindWords" to "KindWords", "Copy of SuperFont"
to "SuperFont", and "Copy of Dictionary" to "Dictionary”. To do so,
go to the menu titled "Workbench" and select the "Rename" option.
When the edit box with the disk title appears, click the pointer on the
cursor block that is in the edit box. Press the delete (Del) key 8 times to
remove "Copy of " from the title name and then press the RETURN
key. Your KindWords copy should now be named just like your
original. You should now do the same with your SuperFont and
Dictionary disks.

512K Amiga 500 or Amiga 1000

Read This Only If KindWords works in 512K of memory. However, because of
Your Amiga Has limited memory space there are some constraints. To fully
512K utilize KindWords it is highly recommended to upgrade your
machine to 1 megabyte. If you do so, you will be able to use the
Spell-Checker, Thesaurus and the SuperFonts.
This is what we recommend if you have a 512K system:

* Do not run any other programs at the same time.

An Introduction to KindWords 3
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KindWords

Close all windows before starting KindWords.
Do not run KindWords from the CLI

Use 4 color screen only

Do not open the WorkBench

Disconnect all external drives (incl Harddisk)
Do not Insert graphics

Do not use any other fonts than the ROMAN 12
Do not use any other style than PLAIN

Installing KindWords on a Hard Disk

Read this section only if you own a hard disk.

1.

2.

Create a drawer named KindWords on your hard disk.

Drag the KindWords icon, Examples drawer, and
SuperDrivers drawer from the KindWords disk to the
KindWords drawer on the hard disk.

Drag the "fonts" drawer from the KindWords disk onto
the hard disk parent directory. If you already have a fonts
drawer on your hard disk do not drag the KindWords
fonts drawer onto the existing fonts drawer in your hard
disk parent directory. This will create a fonts drawer
within a fonts drawer. Rather, place the KindWords fonts
drawer next to your existing fonts drawer.

Drag the fonts drawer from the SuperFont disk to the
KindWords drawer on the hard disk.

Drag the Dictionary icon and Thesaurus icon from the
Dictionary disk to the KindWords drawer on the hard
disk.

You need to re-assign the device names indicating where
KindWords resides on the hard disk. We recommend you
modify your startup-sequence file in the s drawer from your
startup disk. You can use KindWords to do so, but remember
to save the file as ASCII (for more information on opening and
saving files read the Working with Documents section.)

Add the following three lines after the last assign line on the
startup-sequence file:



assign KindWords: dh0:KindWords
assign SuperFont: dh0:KindWords
assign Dictionary: dh0:KindWords

Using the Mouse

In order to operate KindWords and the Amiga you must use the

mouse. Note that the mouse has a right and left button. The
right button is used to invoke the pull-down menus, as
described below. All other operations (opening documents,

selecting text, moving the pointer, etc.) are accomplished with

the left button.

Opening KindWords

1. Turn on the Amiga and your monitor. Insert your

Kickstart™ disk (Only for Amiga 1000) into the internal

drive when you are asked to.

2. When the Amiga asks for a Workbench disk, insert the

KindWords disk.

3. Using the mouse, move the pointer to the KindWords disk

icon and double-click the left mouse button. A small

window appears with icons for KindWords, Preferences,
a System drawer, a SuperDrivers drawer, fonts drawer,

an Examples drawer, an Empty drawer, and a Trash
Can.

4. Double-click on the KindWords icon in the window.
When the KindWords screen appears you're ready to
begin.

About Workbench

KindWords uses the system clipboard to save the cut or copied

text or graphics. Therefore, you must not write protect the
current Workbench.

An Introduction to KindWords
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KindWords

If you decide to use another Workbench with KindWords, copy
the KindWords icon and SuperDrivers drawer to that
Workbench.

Preferences

Preferences is located on the SuperFont disk. To access
Preferences insert the SuperFont disk in an external drive
if you have one or replace the Program disk with the
SuperFont disk in the internal drive. Double-click on the
SuperFont Disk icon and then double-click on the
Preferences icon.

When you select the Save button in Preferences all the
current Preference settings will be automatically saved to
the KindWords Program disk.



The KindWords Screen

After opening the KindWords application, you should see the

KindWords screen displayed on your monitor. The screen
looks like this:

1. The Title and Menu Bar
2. The Line Spacing & Text Alignment Icons
3. Regular and Decimal Tabs
4. The Ruler
5. The Document Window
6. The Scroll Bars
1 4\
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The Title Bar tells you the program name ("KindWords"), the
name of the document which is currently open, and the page on
which the cursor is located in the current document. If no
document is open or saved, no name is displayed.

The title bar becomes the Menu Bar when the right mouse
button is held down. A menu appears when you point to one of
six menu headings: File, Edit, Layout, Font, Style, Extra, and
Help. The menu area remains displayed for as long as you
hold down the right mouse button.

An Introduction to KindWords 7



Menu Purpose

8 KindWords

This table describes the functions of each menu.

File

Edit

Layout

Font

Style

Extra

Help

To start a new document, open an existing
document, insert, save, save under another
document, print, print merge, change the number
of screen colors, display the amount of available
memory and quit KindWords.

To undo recent typing or clearing, to cut, copy or
paste selected text, to clear text, copy and paste the
Ruler settings, and select all.

To set the page size, format paragraphs, insert a
page break, add headers or footers to the top or
bottom of pages, set page numbering, and add a
title page.

To type or set selected text in Roman or Novell 8, 12
or 14 point size, Superscript, Subscript, Symbols,
Math, or Greek.

To set selected text in plain, boldface, underlined,
or italic style.

To find and replace words, check spelling, check
the Thesaurus, automatically hyphenate your
document, change the appearance of the
KindWords screen, show true graphic colors, open
or close the Workbench.

To get quick reminders about basic functions and
a list of all keyboard shortcuts.

To select any function within a menu, point to it with the
cursor while still holding down the right button, and once the
function you wish to select becomes highlighted, release the
right button.

Moving Within a Document

To move up or down, use the scroll bar at the right. By pointing
to the bottom arrow and clicking the left mouse button once, you
can move your document down two lines. By pointing to the top



arrow and clicking the left mouse button, you can move your
document up two lines.

You can also use the "elevator,” the rectangle inside the scroll
bar. The elevator tells you which section of the document is
visible on the screen by the elevator's location in the scroll
bar. By pointing to and selecting the elevator, you highlight it
and are able to drag it up and down within the scroll bar. Drag
the elevator up to move toward the top of your document. Drag
the elevator down to move toward the bottom of your document.

The size of the elevator reflects how much text is being
displayed in proportion to the total amount of text in the
document. For example, if the elevator is very large relative
to the size of the scroll bar, most of the document is visible on
the screen. If the elevator is small relative to the size of the
scroll bar, the document is very large and only a small portion
of the document is being displayed.

To move right or left, manipulate the arrows and the elevator
on the horizontal scroll bar in the same manner as the vertical
scroll bar. By pointing to a right or left arrow and clicking the
left mouse button once, you can move right or left by ten
characters.

The Document Window, the largest section of the screen,
displays the text of your document. When you have more than
one window on the screen, such as the header window, the
"inactive" windows each have a ghosted title and drag bar;
you are unable to enter text within them. You can make a
window "active” in place of another by clicking anywhere
inside the window.

Often your document is too long or too wide to fit on the
KindWords screen. KindWords automatically scrolls if you
move your cursor toward a margin set outside the screen
border. With the scroll bars on the bottom and right borders of
the screen, you can move a document up and down or from side
to side by using the pointer and the left mouse button.

An Introduction to KindWords 9



Opening the Read Me For News Document

A special document, called Read Me For News, is on the
KindWords disk. You should read this document to learn
about the latest KindWords changes and improvements.
To open Read Me For News:

1. Double click on the KindWords disk icon.

2. Double click on the Read Me For News icon.

Quitting KindWords
1. Display the File Menu and choose the "Quit" item.

2. If you've made changes to your document but haven't
saved the revisions, a requester asks you if you wish to
save changes to your current document. If you want to
save the changed document, select "Save" (see "Saving
Your Work" in Chapter 4, "Working With Documents").
If you do not wish to save the changed document select
"No" and KindWords will quit without saving the
changed document.

10 KindWords



EDITING TEXT

Before getting into the mechanics of editing, you need to know
how to enter text into your document, move around in the text,
and specify the text you wish to work with.

Typing in Text

Typing text with KindWords is just like using a typewriter,
except that you only need to press RETURN at the end of
paragraphs rather than at the end of each line. After you press
RETURN, KindWords automatically starts a new paragraph
for you. You may adjust the paragraph indentation marker in
the ruler area to have KindWords automatically indent
paragraphs for you. (See Chapter "Formatting Text")

Using the Cursor

The cursor appears in the document window as a vertical bar.
Be sure to distinguish between the cursor and the pointer. The
Pointer is the arrow which is used to control operations of the
program (menus, ruler selection, etc.). The cursor is a small
vertical bar which indicates where text editing will occur.
The pointer can be moved anywhere and is controlled by the
mouse, but the cursor appears only in KindWords text.

As you type, the cursor moves to the right. The cursor can only
appear in text; it cannot be moved where no text has been typed.

There are 3 ways to move the cursor within text:

1. Pointing to where you want the cursor and clicking the left
mouse button.

2. Using the arrow keys.
3. Using one of the keyboard shortcuts.
Type in a few paragraphs of text. For now, use the

BACKSPACE and DEL keys to correct your mistakes. The

Editing Text 11



BACKSPACE key erases the character to the left of the cursor
and the DEL key erases the character to the right of the cursor.

Selecting Text

When you do major editing with text, such as copying or
moving text, you need to tell KindWords what text you want to
work with. This is called selecting the text. To select text
means to highlight characters, words, lines, sentences,
paragraphs, pages or entire documents for the purpose of
cutting, erasing, moving, or in some other way changing their
format and appearance. Highlighting reverses the color of the
text. There are several ways to highlight text:

Using the Pointer 1. Point to the beginning of the text you want to select.

2. Hold down the left mouse button and move the pointer to the
end of the block to be selected. As you do, the text between
the place you first held down the left button and the current
pointer position is highlighted.

3. Release the left button. To un-select, click the left mouse
button once anywhere inside the document window.

OR:

1. Point to the beginning of the text you want selected and
click the left mouse button.

2. Press the SHIFT key.

3. Move the pointer to the end of the text you want selected,
and while still holding down the SHIFT key press the left
mouse button.

There are also ways to quickly select a word or sentence.

To select a word 1. Point to a word you want to select.

2. Quickly double-click on the left mouse button.

12 KindWords



To select a
sentence

To cut a block of
text

To paste text

To copy text

To clear text

1.

2.

Point to a sentence you want to select.

Quickly triple click on the left mouse button.

Note: If you have trouble double or triple clicking the mouse, increase
the delay in Preferences, and then restart KindWords.

Editing Text
1. Select the text to be cut.
2. Display the Edit Menu and select the "Cut" function by

releasing the right mouse button when "Cut" is
highlighted. The selected text disappears to be held in the
clipboard. The Clipboard acts as a storage place for the
last cut or copied text.

Move the cursor to where you want to insert the text you just
placed in the clipboard.

Display the Edit Menu and choose the "Paste” item. The
most recently cut text is inserted into the main text from
the clipboard.

Select the text to be copied.

Display the Edit Menu and choose the "Copy" item.

Move the cursor to where you would like the text repeated.
Display the Edit Menu and choose the "Paste” item.
Select the text to be cleared.

Display the Edit Menu and choose the "Clear” item. The
text is deleted. If you made a mistake and you wish to
retrieve the cleared text, select "Undo Clear” from the Edit

Menu. You can no longer select the Undo function once
you have moved the cursor.

Editing Text 13




To join
paragraphs

To insert text

To replace text

To undo

everything typed
since the last left
mouse button
click

To copy the Ruler

14 KindWords

Press DEL with the cursor in the character space following a
period at the end of a paragraph. (If you have made format
markers visible using the "Screen Options” item in the Extra
Menuy, you are deleting a paragraph marker.)

1. Point to where you want to add text.

2. Bring the cursor to the spot by clicking the Left Button, and
type. KindWords moves the existing characters to the
right of the cursor when typing.

1. Select the text to be replaced.

2. Start typing. The selected text is cleared and replaced by
the new text you type.

1. Display the Edit Menu and choose the "Undo Typing"
item.

Note: KindWords will only remember the last 256 keystrokes when
executing Undo.

Copy & Paste Ruler

The Copy Ruler command copies the format settings of the
paragraph that the cursor is currently in or the beginning of
the current selection, so that you can subsequently paste them
with the Paste Ruler command. It's as though there's a
separate Clipboard for the Ruler, and Copy Ruler replaces
what's already on it, just as the Copy command does for text.

1. Place the cursor in the paragraph which contains the
format settings you wish to copy.

2. Display the Edit Menu and choose the "Copy Ruler” item.
The current paragraph format is now copied.

The Paste Ruler command selects the paragraph containing
the cursor or the current selection and replaces its paragraph
format settings with the last ones you copied with the Copy




To paste the
Ruler

To select all the
text in your
document

Ruler command. If the current selection is more than one
paragraph, Paste Ruler selects all the paragraphs that are
selected or partially selected and replaces the Ruler settings
for all the selected paragraphs.

1. Place the cursor in the paragraph or select the paragraphs
you wish to change the paragraph format to.

2. Display the Edit Menu and choose the "Paste Ruler” item.
The paragraph format that was last copied will now be
used in the current paragraph or selected paragraphs.

Select All

The Select All command lets you quickly select all the text in
your document. Keep in mind that the Select All command
will only select all of the text in the currently opened window.
The Header and Footer can only be selected when their
respective windows are open.

1. Display the Edit Menu and choose the "Select All" item.

All the text and graphics in the currently active window
will be selected.

Pressing the SHIFT key with the F5 key is a keyboard shortcut
for this command.
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FORMATTING TEXT

KindWords has several options for changing the format of text
in your documents. This section will cover some of the
simpler formatting options that KindWords offers.
(Formatting options like different font sizes and styles,
headers and footers, and page size, are covered in the
"Advanced Features" chapter.)

Using the Ruler

The Ruler sets the left and right margins, paragraph
indentation, line spacing and text alignment of the selected
paragraph(s). By using the Ruler you can set up sophisticated
formats like hanging indentations and formats for quoted
text.

Margins and indentation are modified using the margin and
indentation markers in the Ruler . The top orange triangles
represent the left and right margins. The bottom blue triangle
represents the margin for paragraph indentation. To move a
triangle along the ruler, select it and "drag" it to where you
want it. Moving the paragraph indentation marker to the
right of the left margin marker will set up automatic
paragraph indentation. Moving the paragraph indentation
marker to the left of the left margin marker will set up
outdented or hanging indentation paragraphs.

Line spacing and text alignment are also controlled by the
Ruler. Select the appropriate Line Spacing icon to make your
text single-spaced or double-spaced. Select the appropriate
Text Alignment icon to make your text flush left, centered,
flush right, or fully justified.

Tabs are typically used to set up columns of text for tables in a
document. Select regular typewriter tabs (regular tabs) or tabs
which evenly line up the decimals of numbers (decimal tabs).
To set tabs, use the regular tab and decimal tab icons in the
upper left of the screen inside the Ruler. The solid blue
triangle represents regular tabs, and the open triangle
represents decimal tabs. Select and "drag" the tab icons to the
settings you choose. You can set up to ten tabs per paragraph.

Formatting Text 17
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Format Requester

After using the KindWords Ruler for a while, you may find it
faster to set up the format of a Ruler all at once, rather than
using the ruler to first set the margins, then the line spacing
and then the text alignment for a paragraph. KindWords
provides just such a short cut. Select "Format..." from the
Layout menu. You will be presented with a requester which
allows you to set all the paragraph formatting options at once.
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You can begin by selecting your left and right margins and
your paragraph indent by entering ruler numbers in the upper
left boxes. The minimum amount of space between the left and
right margins is two characters. The maximum is 200.

Next, select the appropriate Text Alignment icon in the upper
right to make your text flush left, centered, flush right, or fully
justified. Select the appropriate Line Spacing icon to make
your text single-spaced or double-spaced. Unless you tell it
differently, KindWords automatically aligns your text on the
left, single-spaced.

Select tabs, if you need them, by entering the amount of space
between tabs in the boxes beside "Set tabs every:". Tabs are
automatically set every five spaces unless you instruct
KindWords differently. You can have up to ten tabs per



paragraph. When selecting tabs in the Format Requester
mode, the tabs will not appear in the ruler. If you later select
tabs in the ruler mode, the tabs that were previously selected in
the Format Requester mode will be deactivated.

Select the "OK" button to implement your choices and return to
the KindWords screen.
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WORKING WITH
DOCUMENTS

This chapter will show you how to save your documents and
open them later for further editing or printing. It will also

show you how to insert other documents, including graphic
files, into the document you're currently working on.

Saving Your Work

When you finish entering a new document, you must give it a
name and then have KindWords save it by putting it on a
document disk. If you don't save it on disk, the document will
be erased when you quit KindWords. To save a KindWords
document, use the following procedure:

1. Select the File menu and choose the "Save" item.

2. Remove the KindWords disk and insert a document disk.
If you have another disk drive, keep the KindWords in the
internal drive and insert a document disk into the
external drive.

3. The Save requester will contain a mini-window
displaying all the files in the current disk. If you have
more document names than fit in the mini-window, you
can use the scroll bar located on the right of the mini-
window to move the list of names up or down.

If you wish to save the document in an existing drawer,
click once on the drawer in the mini window. It will then
display all the files in that drawer. Notice that all
drawers contain the extension "(DIR)".

Once you are in a drawer, "/Parent (DIR)" appears at the

top of the mini window. Clicking once on it will allow you
to back out of a drawer quickly and easily.
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4. Click the left mouse button in the box labeled "File" and

type the name you wish to give your document. If you use
the same name as another previously saved document, a
requester appears asking you if you want to overwrite the
previous document with the current one. If you don't wish
to, type a new name.

5. The requester also tells you to which drive KindWords

will save the document, and provides a button for
changing the drive if you wish to save the document to
another disk. The button is located under the text "in
Drive:" on the right half of the requester.

To change the current drive you are saving to, simply
press the Drive button and the next available disk drive
(or other device) will be displayed in the mini-window.
Notice that KindWords will go through all the available
disk drives or devices when you repeatedly press the Drive
button.

Notice also that the current drive is also displayed within
the Drive button. This button is also available in the Open,
Insert, and Print Merge requesters. Below is an
illustration of the Open requester. Notice that the Drive
button is located on the right half of the requester with DF1:
as the current device.
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Some Notes on
Saving

6. KindWords automatically makes a backup copy of your
document unless you select "no" for the backup option.
The backup copy is the former version of the document.
When a backup file is made, the Workbench features two
document icons, one with the original file name and the
other labeled "___ .backup".

7. You must tell KindWords what type of file you want your
document to be. There are two types:

a) Document - Saving a file as a "Document” saves all
the margin settings, type styles, line spacing,
graphics images that were inserted and other
conditions with which you created the document. All
KindWords Documents are in Interleaved File
Format (IFF).

b) ASCII File - This saves only your text in a standard
format, without margin settings, type styles, graphics
images and so forth. This is useful, for example,
when you want to use the text of your document with a
telecommunications program.

8. Select the "Save" button to store the document according to
the options you've chosen. The disk drive will grind
away for a moment, and then your document reappears on
the KindWords screen. If you choose "Cancel” instead,
KindWords returns you directly to your document,
without saving it to the disk.

You may also save your document by pressing RETURN after
typing in a file name in the "File" box. First, however, be sure
the rest of the options in the requester are the way you want
them.

¢ If you choose "Save" from the File menu when you're
working on a previously saved document, the current
version is saved automatically, and the requester does not
appear.
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*  When you select "Save As" from the File menu, the Save
requester appears. If the document was previously saved,
the title of that document appears in the "File" box. You
can change the name in order to make two copies of one
document.

¢ Ifyou're typing a lengthy document, it's a good idea to
save it often while you're working on it. That way you'll
have an up-to-date copy in case the power to your Amiga is
interrupted.

* Sometimes you may forget to save your current document
and try to start a new one or work with an old one. If you
do, KindWords displays a requester asking you if you
wish to save changes to your current document. If you
want to save the changed document, select "Save", if you
do not wish to save the changed document select "No" and
KindWords will proceed with the last command without
saving the changed document.

Opening and Inserting Other Files

This section will show you how to open files for editing,
formatting or printing. It will also show you how to insert
other files, including graphic files, into a document on which
you are working.

1. Select the File menu and choose the "Open" item.
2. Alist of files appears in a mini-window in the requester.

3. To identify the drawer and file you want to obtain, follow
the same procedure as described above when saving a
document.

4. The requester tells you which is the current drive, and
provides a Drive button for changing the drive if you wish
to open a document from another disk. Simply click the
Drive button until the drive you wish to open a file from is
displayed.



To insert a
document

To insert a
graphic file

5. Once a document name is displayed in the box labeled
"File", select the "Open" button at the bottom of the
requester to open the document onto the screen or double
click on the file in the mini window.

Another way to open a file when you are in the
Workbench, is to double-click on the document icon in the
Workbench screen. KindWords will be opened with the
selected document.

Inserting Documents

In addition to the ability to open documents, KindWords lets
you insert documents into a document that you are currently
working on.

1. Move the cursor to the position where you want the
document inserted.

2. Select the File menu and choose the "Insert" item.

3. Follow the same instructions as when using the Open
requester. Select the document you wish to be inserted and
click the "Insert” button to insert it.

Inserting Graphics

One of the special features of KindWords is the ability to insert
graphics into the text of your document.

KindWords allows you to insert graphics made by any
program which saves pictures in Interleaved File Format
(IFF) format. You may insert low resolution (320 x 256 pixels)
or medium resolution (640 x 256 pixels) images. You may use
high resolution images (640 x 512 or 320 x 512) but KindWords
will reduce them to medium resolution by removing every
other horizontal line of pixels.

1. Move the cursor to the position where the graphic is to be
inserted.
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2. Select the File menu and choose the "Insert" item.

3. Select a graphics file to be inserted in the same way a
regular document is inserted and click the "Insert” button
to insert it.

If the inserted graphic contains more than 16 different colors,
the colors will be recomputed to fit into 16 colors. This
conversion takes about one extra minute when inserting the
graphic.

When you insert graphics in your documents, KindWords
adds some invisible space around the graphic in order to
adjust each printer's resolution. That space will actually not
be printed. Use the Visible Format Markers from the Screen
options requester in the Extra menu to better see the division in
actual space.

If you stretch your graphic higher than a single page, the
graphic will be printed over two pages and your entire
document will not be correctly paginated.

If you stretch a graphic wider that the printer's carriage, the
graphic will be printed cropped on the right edge.

Editing Graphics

KindWords allows you to modify graphics which you have
inserted into a document. You can move a graphic
horizontally within your document, crop a graphic on all four
sides, and resize a graphic proportionally or
nonproportionally. You can also display the original colors of
the graphic.
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To move a graphic 1.
horizontally on
your page

To crop a graphic 1.

Select the graphic by placing the pointer over the graphic
and pressing the left mouse button. The Graphic Frame
will then be displayed.

Keep the pointer over the graphic, and while holding down
the left mouse button, "drag" the graphic left or right.

Releasing the mouse button will place the graphic in the
Graphic Frame's current position.

Select the graphic by placing the pointer over the graphic
and pressing the left mouse button. The Graphic Frame
will then be displayed.

Notice that the Graphic Frame contains small editing
boxes on all four sides.

Place the pointer over the editing box that is on the side you
want cropped.

Keep the pointer over the editing box, and while holding
down the left mouse button, drag the editing box.

Releasing the mouse button will display the graphic in the
Graphic Frame's current cropping size.
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Note that the edit boxes on the left and right sides of the
Graphic Frame crop vertically and the editing boxes on
the top and bottom sides crop horizontally.

1. Select the graphic by placing the pointer over the graphic
and pressing the left mouse button. The Graphic Frame
will then be displayed.

Notice that the Graphic Frame contains a small editing
box in the lower right hand corner.

2. Place the pointer over this editing box.

3. Keep the pointer over the editing box, and while holding
down the left mouse button, drag the editing box.

Notice that the Graphic Frame dynamically resizes
according to the movement of the mouse.

Releasing the mouse button will resize the graphic in the
Graphic Frame's current size.

To resize a graphic proportionally, hold down the SHIFT
key, place the pointer over the lower right corner editing
box, and while holding down the left mouse button, drag
the editing box. The graphic will then be resized
proportionally.

Setting the Colors

KindWords allows you to insert graphics which use up to
sixteen different colors. To conserve on memory, KindWords
will initially use four colors to display images on the screen.
You can set KindWords to display up to 16 colors on the screen.
Although this takes more memory and slows KindWords
down, it is helpful to see what a graphic will look like in full
color before it is printed. When printing, KindWords uses all
the colors of your graphics no matter how many colors are
being used to display the graphic on the screen.



To change the
KindWords colors

Display the File Menu and choose the "Screen Colors"
item.

Since KindWords is always displayed in 640 x 256
resolution, you can only choose to have 4, 8 , or 16 colors.

Choose the amount of colors you wish to display
KindWords in.

Select the OK button to accept the new color setting.
Note that the new color setting will be saved on disk so that

when KindWords is rebooted, the last color setting that
was chosen will be displayed.

Displaying a Graphic in its Correct Color

KindWords uses its own color choices when displaying
images on the screen. You can use the Show Picture Colors
option in the Extra Menu to display the original color for a
graphic.

1.

2.

Select a Graphic.

Select Show Picture Colors option from the Extra menu.
KindWords will now use the colors used to draw that
image. At this point, the "Show Picture Color” option will
change to "Show KindWords Color", allowing you the
option to switch back to KindWords' own color set.

If a graphic's correct colors are not being displayed, it is
because the graphic was created using a larger number of
colors than is currently set in KindWords. Remember you
can change the number of colors from the Screen Colors option
in the File Menu.
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To print a
document

PRINTING DOCUMENTS

This chapter explains how to print your document. Make sure
the printer you are using is selected in Preferences. Many
printing problems are a result of the wrong printer selected in
Preferences.

Before Printing

KindWords prints whatever document is on the screen. If you
own a dot-matrix printer, your document may be printed with
graphics and SuperFonts if selected, as described below. If you
own a color printer, your graphics will be printed in color. If
you own a letter-quality (i.e., daisy wheel) printer, your
document will be printed without graphics and SuperFonts.

1. Select "Print" from the File menu.
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2. Select whether your printed document is to be Draft, Final,
or SuperFont quality.
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Draft Quality will use fast low resolution printer fonts.
This quality is useful to get a quick idea of what your
document will look like when printed. Do not be surprised
if your print out is not exactly what you see on your
computer screen. Fonts; Roman and Novell 8, Roman
and Novell 14, Symbols, Math, and Greek will substitute
Roman 12 in place of them. Superscript and subscript will
also substitute Roman 12 if the printer does not support
them.

Final Quality will use the printer's built-in NLQ (Near
Letter Quality) font in place of Roman 12. If your printer
has a nice NLQ font, it would be a good idea to use Final
Quality. This quality will use your printer's internal
final font for Roman 12 and SuperFonts for Roman and
Novell 8, Roman and Novell 14, Symbols, Math, and
Greek. This is because most printers do not have these
fonts built-in and can not recognize them.

SuperFont Quality is a special feature of KindWords that
will print the whole document in very high-resolution
SuperFonts giving you the highest print quality. Details
on SuperFont Quality printing are discussed later in this
section.

Click on the box labeled "Number of Copies" and type in
how many times you want your document printed.
KindWords prints only one copy unless you tell it
otherwise.

Select the kind of paper your printer uses. KindWords
assumes that you're using continuous-feed paper unless
you tell it otherwise. If you're using single sheets,
KindWords displays a requester during printing that
asks you to insert the next piece of paper; do so, and then
select "OK" in the requester to continue. If you're using
continuous-feed paper, KindWords prints your document
from start to finish without stopping.

The "Print from Page" boxes automatically indicate the
first and last page numbers respectively of your
document, according to KindWords' pagination. If both
boxes are made blank, the document is printed as if the
automatic page numbers were in the boxes.



KindWords' automatic page numbers are affected by the
"starting page number" option in Page Numbering requester.

If the first or last page you want to print is different from what
KindWords automatically indicates, select each box and type
the page numbers you want. KindWords then prints only that
segment of the document.

Printing
Make sure your printer is turned on and that the top of the paper
is aligned with the print head.

Some Amiga printer drivers send an extra carriage return
command to the printer before it actually begins printing.
Experiment with your printer and then adjust your page
accordingly before printing so that your document is printed
correctly on each page.

Select the "Start Printing” button at the bottom right of the
requester.

OR

Select "Cancel” to eliminate the requester and return to the
current document.

After the "Start Printing” button is selected, requesters with
error messages may indicate that the printer is turned off, not
connected, out of paper, or jammed. A problem in the
transmission of the document between the Amiga and the
printer also causes a requester to appear. Select the "Cancel”
in the error requester to end printing. If you fix the problem
select "OK" to resume printing.

If you are having problems with the printout, it may be that
your printer does not support some of the KindWords special
features such as boldfacing, underlining, degree of quality,
graphic printing, color printing, and so forth.
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Printing with SuperFonts

SuperFont Quality printing is a very special feature that
allows you to print KindWords fonts; Roman and Novell (in
8, 12, and 14), Symbols, Math, and Greek. Printing in
SuperFont quality will make even a low cost printer print like
an expensive high quality printer!

When printing in SuperFont qualityKindWords will ask you
to insert the SuperFont disk in any drive if it is not in one
already. Once the SuperFont files are downloaded, your
printer will begin to print your document.

What You Should When printing in SuperFont Quality, KindWords looks at the

Know About printer driver set in Preferences and then looks for its own

SuperFont special custom made printer driver in the SuperDrivers
directory on the KindWords disk. These drivers have the
same name as the ones in Preferences but will contain a
".PRN" extension. All you have to do is make sure the correct
printer driver is set in Preferences.

Here is a list of the special custom made SuperDrivers in the
Superdrivers directory:

Note: If for any reason you wish to access the SuperDrivers, you can
do so only through KindWords or CLI, although there should be no
reason for you to modify the settings.

1. CBM_MPS1000.PRN

2. EpsonX.PRN
The EpsonX driver can be used for all Epson 9 pin printers
such as the Epson EX/FX/JX/LX/MX/RX and compatibles.

3. EpsonX-No_NLQ.PRN
Some printer models that use the Epson Driver do not have
a final quality print mode, such as the Star Gemini 10-X.
Use the EpsonX-No_NLQ driver in Preferences if your
printer does not have a final quality print mode.

4. EpsonQ.PRN
The EpsonQ driver can be used for all Epson compatible 24
pin printers such as the Epson LQ 800, LQ 1000, or 24 pin
Nec printers.
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11.

12.

HP_DeskdJet.PRN

There are some problems with the DeskdJet printer driver.
Please call our technical support to see if there is a new
SuperDriver available or rename the HP_LaerJet.PRN to
DeskJet.PRN.

HP_LaserdJet.PRN

SuperFonts are not supported on laser printers because the
printers own internal fonts are already high quality. If
you wish to obtain SuperFonts for your laser printer please
call our technical support. We will be happy to send laser
printer SuperFonts on a special disk to registered users.

HP_PaintJet.PRN
ImagewriterII. PRN

Okidata_2931.PRN/Okidata_2931.QUAD. PRN

If you have an Okidata 292 or 293 printer, KindWords
gives you two choices of drivers to choose from. The
Okidata_293I driver will print SuperFonts in normal
density. The Okidata_2931.QUAD driver will print
SuperFonts in quad-density. The quad-density print out
is nicer but will take longer to print. If quality is more
important than speed to you, you should use the
Okidata_2931.QUAD driver.

Okimate_20.PRN

The Okimate 20 has problems printing color graphics with
text. You should get better results using a black ribbon
and setting graphics to black and white printing in
Preferences.

Xerox_4020.PRN

The Xerox 4020 has a hardware limitation of only being
able to download 16 characters of SuperFonts per line of
text. This limitation may create errors in your print out.
For best results use only Roman 12 and print in Final
Quality to use the printers own font. This driver will also
support the Diablo_C-150.
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13. generic
If your printer is not supported in Preferences, try using
the generic driver. You will not be able to print
SuperFonts but you should be able to print with your
printers own final quality font.

KindWords has drivers for most of the Workbench supported
printers except for:

Alphacom_Alphapro_101
Brother_HR-15XL
Qume_LetterPro_20

In the future, KindWords will support many more printers
with SuperFonts.

If you are having problems with your printer, check the
Trouble Shooting Chapter. Open the Read Me For News
document to see if there is more information on printers.



Below is a list of printers that KindWords is known to support.

Company Printer Printer Driver
Apple Imagewriter II ImagewriterIl
Apple Imagewriter ImagewriterlI
Brother 1509 EpsonX (1)
CIE CI-3500 CBM MPS1000
CIE Lips 10 EpsonX (1)
Citizen MSP series EpsonX
Commodore MPS-1000 CBM MPS1000
Diablo C-150 Xerox_4020
Epson Epson EpsonX

Epson FX series EpsonX
Epson JX-80 EpsonX

Epson LX series EpsonX
Epson MX series EpsonX
Epson RX series EpsonX

Juki 5510 EpsonX

NEC CP2 & CP3 EpsonX

NEC LQ series EpsonQ
Epson LQ series EpsonQ
Okidata Okimate 20 Okimate 20
Okidata 192 & 193 Okidata_293I
Okidata 292 & 293 Okidata_293I
Panasonic 1080 EpsonX
Panasonic 1091 EpsonX
Panasonic 1092 EpsonX
Panasonic 1592 EpsonX

Star All series EpsonX

(1) To use the EpsonX driver, the printer must be in Epson
mode.
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USING THE HELP MENU

KindWords provides you with two kinds of on-screen help,
available through the Help Menu.

The Quick Reminder item in the Help Menu will remind you
of things you might have learned about KindWords but may
have forgotten. It displays and labels various basic
KindWords icons, and describes the function of each. You
can also display the Quick Reminder by pressing the HELP
key.

The Keyboard item in the Help Menu is a reference tool that
displays a scrollable window containing a list of keyboard
shortcuts to using the mouse. You can also display the
Keyboard item by simultaneously pressing the HELP and
SHIFT keys. By clicking on the scroll arrows at the right of
the window, you can move up and down the list of all keyboard
shortcuts.

Using the Help Menu 39






ADVANCED FEATURES
Changing Font and Style

At first, all the characters you type appear in Roman 12, Plain
style. You can change the font and style by using the Font and
Style Menus. To change the current font:

1. Display the Font Menu.

2. Choose the font for the text at the cursor location. All
characters after that command are in the chosen font until
you make a different choice. The current font is shown by
a check mark in the Font Menu.

You can also change the font of previously typed text.
1. Select the text whose font you wish to change.
2. Display the Font Menu.

3. Choose the font to which you wish to change the selected
text. The selected text should now be in the new font.

If you're inserting text into existing text, it appears in the

same font as the existing text. When the cursor is moved to a
new location KindWords changes the current font
automatically to match that of the character directly to the right
of the cursor.

Styles can be changed in the same manner as fonts, by
selecting from the Style Menu.
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Typing Accents KindWords supports Amiga Keymaps. To type accents you

with Roman and must first press the Alt key simultaneously with another key

Novell Fonts and then press the character you wish to have the accent over.
The following chart describes how to type accents:

. Alt+F | (a,ei,0,u,y)

N Alt+G | (a,e, 1,0,u)

A Alt+H | (a, e, i,0,u)

~ Alt+] | (a,n,0)
Alt+K | (a,ei,0,u,y)

Choosing the Page Size
KindWords will allow you to choose the page size. To do so:
1. Display the Layout Menu.

2. Choose the "Page Size..." item.

|E|KindWords - Page 3 |@O
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designer. Practically speaking, the designer of tonorrow will have to ]
pursue research in the area of the sign. He will not be able to

simply let the machine transfer a design onto the printing carrier,
Reproduction techniques themselves have spread so pemvasively that

they can influence the content of a statement. Early lithographic
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The Header (or
Footer) Menu

The Format Menu
in Headers and
Footers

a) Select one of three conventional page sizes, or
determine a special size by selecting the box beside
"Special” and typing your preference. You can type
in any number up to 90 lines.

b) Set the number of lines making up your top and bottom
margins. KindWords automatically makes your top
and bottom margins three lines (half an inch) each
when the document is printed. Select the "OK" button
to implement your choices.

Setting Headers and Footers

Headers appear three lines from the top of a document and
footers appear three lines from the bottom.

When you choose "Header..." (or "Footer..."), new windows
appear. They will be separate text windows with separate
Rulers. Both can hold up to 15 lines of text. Any text that
exceeds 15 lines will not show up in the documents Header or
Footer.

The Header and Footer windows also have pull-down menus
like the main KindWords window, but they are modified for
the specific needs of writing a header or footer.

1. "New Header" clears the header window screen, clearing
any text you may have already typed in.

2. "Close Header" causes the header window to disappear
and the header text to appear on the main document.

—

"Insert Page Number" will insert the page number at the
current cursor position. The type of page number and page
at which numbering begins can be set from the Page
Numbering requester in the main KindWords window.

2. "Format..." is identical to the same item in the main

document's Format Menu, except that it only affects the
Ruler header window.
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3. "Insert Date" and "Insert Time" automatically insert the
current date and time at the cursor's last position in the
header window. Date and time can be set in Preferences
in the Workbench.

Any text in the main document that was created in the header
or footer windows can be changed only by opening the header
or footer windows and changing the text within them. The
main document cursor does not move onto text created in
header or footer windows.

Close the header, display the Format Menu, and notice the item
"Add Title Page." Selecting this item changes it to "Remove
Title Page," thereby preventing a header or footer from
appearing on the first page of the document. Re-selecting it
changes the item back to "Add Title Page,"” and allows a
header or footer to appear on the first page of the document.

Changing Screen Display

You can affect the appearance of your screen in several ways.
To list some of your choices, display the Extra Menu and
choose the "Screen Options..." item.

IE|KindNords -
Screen Options

Ruler: ®Visible Olnvisible
Fornat Markers: OVisible ®Invisible
Left Margin Lock: OOn ®O0ff

Text Area Color: ®Kindlords OHWorkbench

I ok |1 cancel |

Gewerbeschule since 1M47. He trained at the Zurich Kunstgeverbeschule
and Ias wrked as a 1ithographer as vell as & graphic designer. Ina
1956 Hofwann lectured at the International Pesign Conference in Aspen,
and he has spoken on educational problens before design associations
and af institutions in both the U.$. and Eurgpe. He teaches six weeks
of every year at the School of Art, Yale University, and since 1988
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You can choose to have the Ruler appear on the KindWords
screen by selecting the "Visible" or "Invisible” button
beside the "Ruler” option. Making the ruler area
invisible displays three more lines of text on the screen,
but it also makes your margin markings and line space
icons invisible.

Select between visible or invisible format markers. The
markers look like this:

Paragraph marker: q
Space marker:

Tab marker:

Page break marker:
End marker:

Oewonl|

Format markers are not printed with the document.

3.

If you want the left margin of your text to always be next to
the left border of the KindWords window, select "On" for

the "Left Margin Lock." This will allow you to see more

horizontal text on your screen.

Choose whether you want text in the document window to be
black on white ("KindWords") or white on the

Workbench background color ("Workbench") in the
"Text Area Color" option.

Select the "OK" button to save your choices. Your choices
are maintained throughout rebooting and all new
documents until you change them. If you want to change
the cursor and its color, call up Preferences from the
Workbench.

Finding and Replacing Text

The KindWords "Find and Replace” item in the Extra Menu
allows you to find any word or string of characters and spaces
and replace it with another string. The text is automatically
realigned when text is replaced.
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1. Display the Extra Menu and select the "Find and
Replace" item. A requester appears with boxes labeled
"Find" and "Replace,” and a series of buttons.

|EIKindNords - Page 3 |@[D
Find and Replace

Find:

Replace: [IEYICN

| Find Next | [Replace] [Replace Then Find] [Replace All][Done “

R Match Case O Rhole Word

A. K, Cassandre
Nord Express

In the future, electronic advertising media will strongly corpete with
the BB The poster has a chance of survival only if it recollects
its most innate strength: size, clarity and sivplicity, Of course,
these formal necessities must be realized within the context of more
corplex information. this will require some effort on the part of the

<+

2. Point to the box labeled "Find," click the Left Button, and
type the string of characters and spaces you want to find or
replace (the "Find" string).

3. Point and click in the box labeled "Replace” and type the
string of characters and spaces you want in place of the
original string. The replacement uses the original
string's type style. If you type nothing in the "Replace”
box, the "Find" string is simply deleted from the text when
you select a replace button.

4. Below the "Replace” box are four buttons and two options:

Buttons:

a) "Find Next" allows you to find and select the next
occurrence of the "Find" string after the cursor, and
to skip that occurrence of the string and go to the next
if you choose. This is useful when you do not want to
replace every occurrence of the "Find" string.



b) "Replace"” replaces the currently selected occurrence
of the "Find" string with the text in the "Replace” box.
If you select the "Replace” button before the "Find
Next" button, a message appears saying "First select
"Find Next"".

¢) "Replace Then Find" combines the "Replace” and
"Find Next" buttons. It eliminates the mouse
movement of switching back and forth between the two
buttons.

d) "Replace All" replaces all occurrences of the "Find"
string, after a requester appears asking you if you're
sure you want to.

Options:

a) "Match Case” when checked will recognize upper and
lower case in the "Find" box and will find all cases of
that word that match in upper and lower case.

b) "Whole Word" when checked will find the string of
text in the "Find" box only when it occurs as an exact
word (example: "cat”). It will ignore occurrences of
the string when the word is embedded within words
(example: "cat" is embedded within "catnip").

5. Select "Done" to return to your document.

Checking for Spelling

KindWords enables you to check for spelling errors in your
document using a dictionary with over 100,000 words that
comes on the Dictionary disk. You can also customize this
dictionary by adding your own words to the Supplemental
Dictionary, as described later in this section.

The Spell Checker will only work if KindWords can find the
files; "Dictionary”, "Supplemental”, "Phonetics”, and
"Corelex”. All these files are located in the "English
Dictionary"” drawer in the Dictionary disk. It is very
important that all the files in the dictionary drawer are
present or the Spell Checker will not work.
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If KindWords can not find the English Dictionary drawer, a
message will be displayed asking you to insert the Dictionary
disk in any drive. Insert the Dictionary disk in any drive to
resume.

If you have copied the contents of the Dictionary disk to your
hard disk and you still get a message asking you to insert the
Dictionary disk into any drive it means that the startup-
sequence file on your boot floppy disk has not correctly been
modified. Read the "Installing KindWords on a Hard Disk"
section in the first chapter to install KindWords correctly on
your hard disk.

1. First you must decide which portion of text you want
checked. The spell checker works like the Find and
Replace in that it checks the portion of text between the
cursor and the end of the document. If you want the entire
document checked, you must place the cursor at the
beginning of the document.

2. Select "Check Spelling..." option under the Extra menu.

Note: If your Amiga has more than 512K of memory you will be asked
if you want to load the dictionary into memory. This will
significantly increase the speed of checking a document. Select the
"Yes" button to load the dictionary into memory.

If KindWords finds a word it does not recognize, you will be
presented with the Check Spelling requester.




To edit a
misspelled word

To display
spelling
suggestions

To correct all the
occurrences of the
same misspelling

To ignore a
misspelled word

To add words to
the dictionary

IBIKindHords - Page 1 [@[f
Check Spelling

Replace! Dictionany:
proliferating proliferating 4

[ ignove | [  Sugyestions | |prolifevative i

—— proliferation
|_Replace | |Add to Dictivnary] lppoliferations 1

[Repiace ati] [ Voo | y

The Aniga is beconing firnly established as the artist’s
computer. MWhile video and graphics prograns are
REEETERER rapidly, a smaller front in the audio field
is making headway. Saplers and sawple editing sof tware
packages are available from several companies.

1. [Edit the word in the "Replace” edit box.
2. Select the "Replace” button.

1. Select the "Suggestions" button. KindWords will display
a list of possibilities.

2. Select the correct spelling from the list and the word will
be copied into the Replace box.

3. Select the "Replace"” button.

-

Select the "Replace All" button.

Sometimes KindWords labels a word as misspelled even
though the word is spelled correctly. This means that the word
is not in the KindWords dictionary.

1. Select the "Ignore” button. KindWords will ignore all
subsequent occurrences of that word in the document

1. Select the "Add to Dictionary" button.
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Once a word has been added to the dictionary it will no longer
be considered misspelled in current or future documents.

The translator is a utility program that you can use to convert
the Supplemental file into a KindWords ASCII file. This will
allow you to then edit the Supplemental File when you are in
KindWords.

Note: Once you have converted the Supplemental file into ASCIT you
will have to close and then reopen the Dictionary Disk in Workbench
to see the Supplemental ASCII file. Double-clicking on the ASCII file
will load it as a KindWords file. You will then be able to remove
words that you added to the dictionary as well as add new words.

Once you have edited the file to your liking and saved it as an
ASCII file you then have to reconvert the Supplemental ASCII
file back to the Supplemental Dictionary File format using the
Translator.

Using the Thesaurus

KindWords has a thesaurus that is always available to you
while you are writing. It can check 40,000 words and provides
470,000 synonyms. It will help you find clearer, more
appropriate ways to say what you mean. You can refer to it at
any time and choose any synonym in the Thesaurus to replace
any word in your document.

1. First you must place the cursor to the left of the word or
anywhere within the word for which you wish to find
synonyms.

2. Select the "Thesaurus..." option under the Extra menu.

If KindWords cannot find the Thesaurus, a message will be
displayed asking you to insert the Dictionary disk in any
drive. Insert the Dictionary disk in any drive to resume.

KindWords will now look at the word that the cursor is in and
search the Thesaurus. It will then display the Thesaurus
requester containing the meaning of the word and list all its
synonyms in the scrollable mini window.




To replace the
current word with
a synonym from
the Thesaurus

IE|RindHords - Page 1 |i|ﬁ|

Replace: Thesawras:

3) noun; the amount of
sonething produced

1 Replace ]|  Next Meaning ] {output
yroduct

[Replace ait] | Caaned ] {turnout

In the field of RENNIEWR the woodcut, the linocut and the etching are
particularly suitable for linear designs because in these original
techniques both the material and the instruments lend themselves
ideally to the production

- il

The meaning will be in black italics text and the synonyms
will be plain blue text. If there are many synonyms for a
particular meaning you can scroll down the list of synonyms
by pressing the arrow on the mini-window scroll bar.

To replace the current word with a synonym from the
Thesaurus simply click the arrow over any of the words in the
mini-window that appear in blue. Notice that the synonym
you clicked on now replaces the current word in the Replace
box in the top left corner of the requester. Now select the
"Replace” button. KindWords will automatically replace the
current word in your document with the new synonym.

If you wish to replace all occurrences of a particular word
without going through every occurrence individually you can
select the "Replace All" button. This command will only
replace all occurrences from the location of the word chosen to
the end of the document or the currently selected area. Note
that if you select the word instead of just placing the cursor in
the word and then select "Replace All" in the Thesaurus,
KindWords will only replace the one word in the selection.
Remember that the selected area is the area that you defined
KindWords to replace the word. All other occurrence of that
word outside of the selection are not replaced.

Sometimes the meaning displayed in the Thesaurus may not
be the correct context of the word in the document.
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Select the "Next Meaning" button. KindWords will then
display a second meaning in the mini-window with
synonyms that can be used for that meaning. Repeatedly
selecting the "Next Meaning" button will cycle through all the
possible meanings. If there is only one meaning of a
particular word, KindWords will ignore the button press.

1. Click on the synonym in the mini-window you wish to
check synonyms of.

Notice that the "Next Meaning" button is now replaced by
a "Check Replace Word" button.

2. Select the "Check Replace Word" button.

KindWords will now check the Thesaurus for the current
word that is in the Replace Edit Field and display its meaning
and synonyms in the mini-window. This will allow the user
to look deeper into possible words to use.

Hyphenating Your Document

KindWords allows you to hyphenate your document. This
will improve the document's overall appearance.
Hyphenation produces lines of text with a more even length by
breaking long words at ends of lines.

1. Select the "Automatic Hyphenation" option under the
Extra menu.

KindWords will now automatically look for portions of words
throughout the whole document that can be moved to the end of
the previous line. The program will automatically insert a
hyphen between the syllables or words. Any new text entered
anywhere throughout the document will automatically be
reformatted with hyphens in the necessary places.

A check mark will appear next to the option "Automatic
Hyphenation" when automatic hyphenation is on. To turn



automatic hyphenation off, simply reselect the "Automatic
Hyphenation” option and all hyphenation will be removed.

Automatic Hyphenation will automatically place hyphens
where necessary in your document but will not necessarily
give your document the best appearance. Instead of Automatic
Hyphenation you may wish to manually place hyphens in
only specific locations. This is helpful when you are finished
typing your document and are working on the layout of your
final printed output.

Note: Automatic Hyphenation slows down typing speed. If you are a
fast typer it would be a good idea to select Automatic Hyphenation
after you have already finished typing your document.

To manually If you find a word that is too large to fit on the previous line, yet
hyphenate your you wish to make the line length more even with the rest of the
document document, you can place the cursor between the characters of

the word that you wish to hyphenate and press the keys (CTRL
+ -). This places a Soft Hyphen at the cursor position. The
word will then adjust with the portion of the characters or word
before the hyphen now located on the previous line. A soft
hyphen is visible only when a word is split across two lines of
text at the location the cursor was in when the soft hyphen was
inserted. The hyphen location will behave like hyphens in
Automatic Hyphenation.

You can remove a soft hyphen by selecting it and deleting it or
backspacing over it when it is at the end of a line and is
visible, or by deleting the word in which it's embedded. When
you backspace over an invisible soft hyphen, the insertion
point won't move but the hyphen will be deleted.

| Note: Soft Hyphens can also be used with Automatic Hyphenation on. |

Print Merge

Print Merge is a special feature to help you in producing
multiple versions of a document. A typical use for this feature
is to create personalized letters to different recipients. The
"Main Document”, which contains the main text of the letter
plus "Merge Words", is combined with a "Merge List"
containing the variable information.
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When print merging, one or more words in a main document
are coded by placing a pair of angle brackets on either side of
each word. These are called Merge Words. These Merge
Words are then replaced during printing with information
from a separate file. The separate file containing the
information that replaces the Merge Words is called a Merge
List. Items in the Merge List replace the Merge Word in the
main document.

For example, imagine that you want to send the same letter to
ten people. You write the letter, but instead of writing any one
of the recipients' ten addresses at the top, you place a code word
<<Address>> in the address position. After saving the letter,
you make a new file containing the names and addresses of
the ten recipients. With Print Merge, you can combine these
files so that the letter is printed ten times, and each time one of
the ten recipients' address replaces the code word "Address.”

You will learn print merging best by doing it. In the following
instructions you will write and save a sample letter
containing Merge Words, type and save three addresses in a
Merge List, and print merge the results.

1. Type the following letter using margins of 5 and 75.
<<Address>>

Dear <<Employee>>,

Thank you for responding to our advertisement for a <<job>>
position. Your past experience tells us that your qualifications
are exactly what we are looking for.

Please contact me as soon as possible.

Sincerely,

Frank Jones

The double brackets on either side of the word "Address",
"Employee”, and "Job" tell KindWords that they are Merge

Words. Your document should look like the next screen
illustration.



Creating a Merge
List

EJ|KindWords - Merge Letter Page 1 |@lD)
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((Adress))

Dear ((Ewployee)),

Thank you for responding to our advertisement for a ((job)) position.
Your past experience tells us that your qualifications are exactly
what we are looking for.

Please contact me as soon as possible.

Sincerely,

Frank Jones

4

2. Display the File Menu and choose the "Save" item. In the

Save requester, type the name "merge sample” in the
"File" box. Click on the "Save" button.

1. You will now create a Merge List. Display the File Menu

and choose the "New" item.

D|KindWords - Merge List Page 1 IEI‘I
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Address

Ewployee

Job

John Swith-232 Dansville Rd.-Stockbridge NI 82948

Mr. Swith

Journalist

Suzanne Ross’12 Blue Lane‘Hollywood,CA 78958

Ms. Ross

secretary

Brian Sinpson’874 Fast Road'Iroy VI 83469

Mr. Simpson ;,
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2. At the top of the screen, type (without brackets) the Merge
Word "Address." press RETURN, then type the Merge
Word "Employee” press RETURN, then type the Merge
Word "job". The three words combine to form a Merger
Header, the first part of a Merge List. It tells KindWords
what information fits where in a print merge. All Merge
Words listed in a Merge Header must be exactly the same,
character for character and space for space, as they appear
in the main document.

3. Press RETURN twice and type the following address. But
instead of pressing only RETURN after the name and
street address as you normally would, hold down the
CTRL key and press RETURN key [CTRL + RETURNI.
Also, because the comma acts as a kind of RETURN key
in a Merge List, you must press [CTRL +,] in place of a
regular comma in the addresses.

John Smith[CTRL +RETURN]232 Dansville Rd.
[CTRL+RETURN]Stockbridge[CTRL + ,]MI 82940[RETURN]
Mr. Smith[RETURN]

journalistfRETURN twice].

Typing RETURN and "Mr. Smith" creates the second line of
the Merge Record, while RETURN and "journalist” creates
the third line, which fit in the places where the Merge Words
"Employee” and "job" are located in the main document.

This list is called a Merge Record. You will type two more
below. Pressing RETURN twice after the end of a line
separates one Merge Record from another. Therefore,
RETURN cannot be pressed within one Merge Record. A
special character, [CTRL + RETURN], acts as a return within
a Merge Record.

In Merge Records, either a RETURN or a comma can separate
elements. That is, you can use a regular comma in place of
RETURN between "MI 82940" and "Mr. Smith" and between

"Mr. Smith" and "journalist”.



Printing with
Print Merge

4. Add the following addresses to the list:

Suzanne Ross[CTRL + RETURN]12 Blue Lane[CTRL +
RETURN] Hollywood[CTRL +,]JCA 78958{RETURN]
Ms. Ross[RETURN]

secretary[RETURN twice]

Brian Simpson[CTRL + RETURN]874 Fast Road[CTRL +
RETURN]Troy[CTRL + ,]JVT 83469[RETURN]

Mr. Simpson [RETURN]

salesman[RETURN twice]

5. Display the File Menu and choose the "Save" item. Type
"addresses” in the "File" box. Click on the "Save"
button.

You now have a file of addresses that will be merged to your
main document when you print merge. That is, you will print
three copies of the main document, each with one of the three
addresses.

To do the print merge, you first have to open the document
"merge sample".

1. Display the File Menu and choose the "Open..." item.
Double click on the file "merge sample”.

2. When the document appears in the document window,
display the File Menu and choose the "Print Merge..."
item. A Print Merge requester appears with a mini-
window displaying all the files.

3. Double click on the file "addresses".

4. Select the "Print" button. The Print requester appears.
Make sure your printer is ready. Select your choice of
printer options that were described earlier in this manual,
then select the "Start Printing” button. KindWords
automatically merges the current document ("merge
sample") with the Merge List ("addresses”) file that you
selected in the Print Merge requester.
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The Examples drawer contains another example of a
merge document called "Sample Merge Letter”, and a
merge list called "Sample Merge list". Try them.

When you are executing a print merge, several conditions
may cause error requesters to appear.

If your main document has Merge Words for which no
information exists in the Merge List file, a requester tells you
that some of the Merge Words were not satisfied in your main
document and displays the first word that is not satisfied. It
also tells you to check the Merge Header in the Merge List to
make sure the words in the Merge Header match the Merge
Words in the main document.

Merge Records are printed in the same type style in which the
corresponding Merge Word is set. For example, if a Merge
Word is in italics, <<Name>>, then it will be printed as
"Joe", also in italics.



Using the
"Keyboard" Item

Moving Through
Characters

Moving to Words
and Paragraphs

USING KEYBOARD
SHORTCUTS

Keyboard shortcuts can be useful as an alternative to using the
mouse if you're familiar with KindWords and want to save a
little time in performing various functions.

There are two kinds of keyboard shortcuts. The first uses a
variety of keys, and is used largely for cursor movement and
text-changing. The second uses the AMIGA key [A] to the right
of the SPACE BAR, and duplicates the function of the mouse in
choosing menu items.

In the "Keyboard" item in the Help Menu, a plus (+) sign
between two keys means press both keys at the same time. For
example, [A] + D means press the right [A] key and the "D" key
simultaneously.

You can quickly refer to a list of keyboard shortcuts by
displaying the Help Menu and choosing the "Keyboard" item.
The following table lists all shortcuts included in the
"Keyboard" item.

Keyboard Editing Shortcuts

[up arrow] Moves cursor up one character.

[left arrow] Moves cursor left one character.

[right arrow] Moves cursor right one character.

[down arrow] Moves cursor down one character.

ALT + [right arrow] Moves cursor to last character of
next word.

ALT + [left arrow] Moves cursor to the first character

of previous word.
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ALT + [up arrow]

ALT + [down arrow]

Tabbing TAB

Moving Through a ALT +[1]

Moves cursor to the first line of the
current paragraph. (If the cursor
is already there, it moves to the
first line of the previous
paragraph.)

Moves cursor to the first line of the
next paragraph.

Moves to next tab setting.

Moves to the end of current line.
(If the cursor is already there, it
moves to the end of the next line.)
SHIFT + [right arrow] can also be
used.

Returns to the beginning of the
current line. (If the cursor is
already there, it moves to the
beginning of the previous line.)
SHIFT + [left arrow] can also be
used.

Moves cursor up one screen.

Moves cursor down one screen.

CTRL + [xxx on numeric pad] Moves to beginning of page xxx.

Page With the
Numeric Pad
ALT + [7]
ALT + [9]
ALT + [3]
Moving to the CTRL + [up arrow]
Beginning or End
of a Document CTRL + [down arrow]
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Moves to the top of the document.

Moves to the bottom of the
document.



Moving the cursor
using the
Numeric Pad

Scrolling the
Display Through
Pages

Deleting
Characters and
Words

Special
Characters for
Print Merge

Ruler Shortcuts

ALT + 8
ALT + 2
ALT +4

ALT +6

SHIFT + [up arrow]

SHIFT + [down arrow]

DEL

BACK SPACE

ALT + DEL

ALT + BACK SPACE

SHIFT + DEL

SHIFT + BACKSPACE

CTRL + RETURN

CTRL +,

Fé6

Moves up one line.

Moves down one line.

Moves left one character.

Moves right one character.

Scrolls to the top of the page. (If the

screen is already there, it moves to
the top of the previous page.)

Scrolls to the top of the next page.
Deletes the character to the right of
the cursor.

Deletes the character to the left of
the cursor.

Deletes the word to the right of the
cursor.

Deletes the word to the left of the
cursor.

Deletes the word the cursor is in.

Deletes the word the cursor is in.

Special character for a return in
Merge Record data.

Special character for using a
comma in Merge Record data.

Moves left margin and indent 5
spaces to the left.
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F7 Moves left margin and indent 5

spaces to the right.

F8 Moves right margin 5 spaces to the
left.

F9 Moves right margin 5 spaces to the
right.

F10 Sets margins to Preferences'

margin settings.

SHIFT + F6 Alternates between single and
double line spacing.
SHIFT + F7 Flush Left
SHIFT + F8 Centered
SHIFT + F9 Flush Right
SHIFT + F10 Full Justified
Selection F1 Selects word to the left of the
Shortcuts cursor.
F2 Selects word to the right of the
cursor.
F3 Selects sentence to the left of the
cursor.
F4 Selects sentence to the right of the
Cursor.
F5 Selects paragraph cursor is in.
SHIFT + F1 Selects line above.
SHIFT + F2 Selects line below.
SHIFT + F3 Selects page above.
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The File Menu

Edit Menu

SHIFT + F4

Selects page below.

SHIFT + F5 Selects entire document.
Amiga Key Shortcuts

ITEM SHORTCUT
[A] = The Right Amiga key

New ((Al+N)
Open... ((Al1+0)
Insert... ((Al+R)
Save ((A1+8)
Save as... ((Al+d)
Print... ([A] + A)
Print Merge... ((Al+ M)
Screen Colors... ((Al+L)
About KindWords... ([A]+K)
Quit (Al+ Q)
Undo Typing ((Al+2)

Cut (Al +X)
Copy ((A1+C)
Paste (Al+V)
Clear ((A] + E)
Copy Ruler ((A1+9)

Using Keyboard Shortcuts
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Extra Menu
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Paste Ruler

Select All

Page Size...
Format...

Insert Page Break
Header...

Footer...

Page Numbering...

Add Title Page

Plain
Bold
Underline

Italics

Find and Replace...
Check Spelling...
Thesaurus...
Automatic Hyphenation
Screen Options...

Show Picture Colors

Open Workbench

([Al+0)

SHIFT + F5

((A1+ 1D
([A1+2)
(Al +3)
([A] + 4)
([A]l +5)
([A]+6)

([A1+7)

([A] + P)
([A] + B)
([A]l + U)

((Al+ D

([A]l + F)
((Al+Y)
((Al1+T)
([A]l + H)
([A]l + D)
((Al+ &)

([A] + W)



Help Menu Quick Reminder (HELP)

Keyboard (SHIFT + HELP)
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File Menu

Edit Menu

FUNCTION FOR EACH MENU

ITEM

New

Open...

Insert...

Save

Save as...

Print...

Print Merge...

Screen Colors...

About KindWords...

Quit

Undo Typing

FUNCTION

To clear the screen and create a
new, blank document.

To bring a document from a disk to
the screen as the current document.

To insert a document or graphic
from a disk into the current
document.

To save a document on a disk.

To save a document under another
name.

To choose printing options and
start printing.

To print multiple versions of the
same document with a merge list

To change the number of colors on
the screen to 4, 8, or 16 colors.

To display the version number and
the approximate percentage of
available memory.

To close current document and
display Amiga Workbench.
(Same as selecting close gadget in
upper left corner.)

To cut or restore all typing since
last mouse click. (Changes to
"Redo Typing" after "Undo
Typing" is chosen.) Also used to
undo clear commands.
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Layout Menu
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Cut

Copy

Paste

Clear

Copy Ruler

Paste Ruler

Select All

Page Size...

Format...

Insert Page Break

Header...

Footer...

To remove selected text from
screen and store it in the clipboard
until next cut.

To duplicate selected text and place
in clipboard for later use with the
paste command.

To paste the most recently cut or
copied text at the cursor's position
or inside a selection.

To clear selected text.

T'o copy the format settings of the
paragraph that the cursor is
currently in.

To paste the paragraph format
settings that was last copied in the
paragraph that the cursor is
currently in.

To select the whole document.

To choose the size and top and
bottom margins of a page.

To set left and right margins,
paragraph indentation, text
alignment, line spacing, and tabs.

To insert page break between the
cursor and next character such that
the next character begins on the
next page.

To place special lines of text at top
of page.

To place special lines of text at
bottom of page.



Font Menu

Page Numbering...

Add Title Page

Roman 8

Roman 12

Roman 14

Novell 8

Novell 12

Novell 14

Superscript

Subscript

To choose the page number type and
the starting number for the pages.
Page numbers are inserted into the
document from the Header and
Footer Windows.

To prevent Header and/or Footer
from appearing on first page of
document. Selecting it changes
item to "Remove Title Page". Re-
selecting it returns it to "Add Title
Page".

Sets selected and new text in
Roman 8.

Sets selected and new text in
Roman 12.

Sets selected and new text in
Roman 14.

Sets selected and new text in Novell
8.

Sets selected and new text in Novell
12.

Sets selected and new text in Novell
14.

Sets selected and new text in
Roman 8, raised characters.

Sets selected and new text in
Roman 8, lowered characters.
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Symbols Sets selected and new text in
Symbols. This font is used to type
special symbols, lines, and boxes.

A L N 1 r ; >
B Q 0 d 2 T , .
c | o P q 3 | 7 ([
D | J Q - 4 *

E | 4 R | ® 5 | &

F > S 1 6 F

G ¢ T ™ 7 >

H 'l U ! 8

[ J v o 9

J a w + 0 ~

K A X - . +

L < Y § - 00

M Z |
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Math Sets selected and new text in Math.
This font is used to type special
math symbols. To get numbers
while in Math font press the Alt key
simultaneously with any number

key.
a | < n 2 Al N | »
b < ) / B — o) L
c 51 p . c | fi P I
d £ q 3 D Q -
e ? r { E | — R -
f 2 S > F § S
g " t 3 G 9 T o
h $ u hd H ° u u
i Y v a I L v ¢
J < w { J ° W —
k > X > K had X 154
I € y P L oc Y 8]
m (<4 z <« M - z «
Math A
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Style Menu

Extra Menu

Greek

Sets selected and new text in
Greek. This font is used to type
special Greek characters.

A A N N a n n
B B 0 Y b 0 o
c X P P c ¢ P p
D D Q Q d d q q
E E R P e e r r
F F S S f f s s
G G T T g g t t
H H U U h h u u
I I Vv v [ i v i
J Y W w j J w w
K K X X k k X X
L L Y v | I y J
M M zZ z m m z z
Plain Sets selected and new text in plain
style.
Bold Sets selected and new text in bold
style.
Underline Sets selected and new text in
underline style.
Italics Sets selected and new text in italics

Find and Replace...

style.

To find a specified string of
characters in order to replace,
delete or simply locate them.
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Check Spelling...

Thesaurus...

Automatic Hyphenation

Screen Options...

Show Picture Colors

Open Workbench

Help Menu Quick Reminder...

Keyboard...

74 KindWords

To find any misspelling and give
suggested spelling in the current
document.

To find the meaning and give
suggested synonyms for the
currently selected word.

To automatically hyphenate your
document.

To make the ruler visible or
invisible; to make paragraph
marker visible or invisible; to turn
left margin lock on or off; to
change the screen color.

To display the correct colors of a
graphic when a graphic's Graphic
Frame is displayed The correct
number of colors must be set in the
Screen Colors requester, which is
in the File Menu.

To open the Workbench and
display it in front of the
KindWords screen. Selecting it
changes item to "Close
Workbench". Re-selecting it
returns it to "Open Workbench".

To display the name and function
of important icons.

To list keyboard shortcuts.



TROUBLESHOOTING

Problem With BackUp Copies

If you are using working copies and find that KW asks to
insert volume KindWords in any driver before opening and
printing:

Rename the copied disc exactly the same name as the original
disc (i.e. your copy should not remain named "Copy of
KindWords" but should be renamed to "KindWords". The
same goes with SuperFonts.

If you have already done that, make sure that there is still not a
space in front of the "K" or "S" (in SuperFonts) when
renaming. Make sure the block cursor is directly over the

"K" and "S" before pressing the RETURN key.

Printing Problems

If you have a Star printer that prints a "1" after graphics
and/or SuperFonts:

Use the EpsonX-No_NLQ driver in Preferences.

If you have a Star printer that prints SuperFonts in segments
and/or graphics print in segments:

Follow these directions:

1. Run KindWords

2. With KindWords disk in df0:, choose Open from the File
Menu.

3. Click on directory SuperDrivers, then double-click on
EpsonX.PRN (or EpsonXNo_NLQ.PRN if you are using
that driver).

4. After file has been loaded, move vertical elevator all the
way to the bottom of the shaft (screen will be blank).

5. Click twice in the shaft above the elevator. (This will
jump the screen up two screen lengths). Locate the
line:"P3 VERT=11 SCAN=0".
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6. Highlight "11" in this line. Press "6". This will replace
"11" with a numeral "6".

7. Select "Save" from the File Menu. Make sure you have
the correct driver selected in Preferences.

Follow these directions if line spacing is too large (This
elongates the page and makes page breaks print in wrong
areas.):

1. Run KindWords

2. With KindWords disk in df0:, choose Open from the File
Menu.

3. Click on directory SuperDrivers, then double-click on
EpsonX.PRN (or EpsonXNo_NLQ.PRN if you are using
that driver).

4. After file has been loaded, move vertical elevator all the
way to the bottom of the shaft (screen will be blank).

5. Click twice in the shaft above the elevator. (This will
jump the screen up two screen lengths). Locate the line:

"P5 VERT=20 SCAN=4".

6. Lower the value of "VERT=20" by 2 values and try
printing. If the line spacing is still too large modify it
again by lowering the value again by 2 values and try
printing. Eventually you should get what you want.

7. Select "Save" from the File Menu. Make sure you have
the correct driver selected in Preferences.

If your graphics still print with horizontal spaces, try setting
your page size to "Custom" in Preferences.

If Boldface does not print in Final on a Panasonic printer:

The following directions will force Bold Roman 12 SuperFont
when printing in Final Quality.

1. Run KindWords

2. With KindWords disk in df0:, choose Open from the File
Menu.

3. Click on directory SuperDrivers, then double-click on
EpsonX.PRN (or EpsonXNo_NLQ.PRN if you are using
that driver).

4. After file has been loaded, click once in shaft below
vertical elevator. Locate line of text:

"FO ROMN12B B LETTER=1 PROP=0"
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5. Highlight the numeral "1" in this line. Press "0". This
will replace "1" with a numeral 0.

6. Select "Save" from the File Menu. Make sure you have
the correct driver selected in Preferences.

If the print out is not correct on a Panasonic KX-P1091i (or
similar model):

The dip switch settings may not be set correctly. They should
be set as follows:

SW1 = ON
SW2 = OFF
SW3 = OFF
SW4 = OFF
SW5 = ON
SW6 = ON
SW7 = ON
SWS8 = OFF

If it is not printing correctly on the Apple Imagewriter or
Imagewriterll:

Most likely the dip switch settings are set incorrectly. For the
Amiga they should be set as follows on switches SW-2:

1=Closed
2=Closed
3=Closed*
4=0Open
5=Closed
6=0Open

Also, make sure you have "Handshaking" set to
"XON/xOFF" in the "Change Serial" screen of Preferences.

If your graphics are printing in black blocks on a black and
white printer:

Make sure you have Preferences set to "Black and White" or

"Gray Scale" printing in the Shade option in the Graphic 1
screen located in the Change Printer screen.
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Inserting Graphics Problems

If you can not insert a graphic into their document because of
memory:

This can happen if you only have 512K of memory. Save the
graphic as a smaller brush and also save it with a fewer
number of bit planes (less colors in color palette).

If it is not working on a hard disk

Read "Installing KindWords on a Hard Disk" in the first
chapter of the manual. Usually the problem is because you did
not modify the start-up sequence file correctly on the boot up
floppy disk.

If the fonts are all in Roman 12 on the KindWords screen:

This means that the font files from the Program disk were not
correctly copied to the fonts directory on the users hard disk.

To make sure you have copied the font files correctly to your
hard disk make sure you have the program disk in df0: and
have it has the current device in CLI. Type this command
from CLI:

"copy df0:fonts fonts all”
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INTRODUCTION

In providing this documentation, an assumption is made that
the user is already well versed in the fundamental areas
necessary to use the Amiga. If the computer is new to you, it
may be beneficial to read through the Amiga manuals in order
to become better acquainted with its interface.

Fusion Paint is not copy protected for your convenience and
economy. It is illegal to make any copy to give to another
person. It is also illegal to use a copy of this program on any
two computers simultaneously for any purpose and by anyone
unless permission has been granted by a superseding license
agreement.

Making a Backup

In order to operate this software program, you will need an
Amiga personal computer with at least 512K of internal
memory and a backup copy of your Fusion Paint program disk
to be used as a working copy.

If you have just opened your Fusion Paint package, the first
thing you should do is backup the program disk. If you are
using Workbench 1.2 or 1.3, you can do this by following these
steps:

1. Turn on your Amiga and load the Workbench.

2. Make certain that the write protect tab on your original
disk is in the write protect position.

3. Insert the original Fusion Paint disk into one of your
drives.

4. When the Fusion Paint disk icon appears on the
Workbench, double-click on the icon to open the Fusion

Paint window.

5. Put a blank disk into a drive.
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6. When the icon for the blank disk appears on the
Workbench,drag the Fusion Paint disk icon onto the
blank disk's icon.

7. The disk copy procedure has started. Just follow the
instructions that are displayed in the various windows
that pop up.

Quick Start

To start Fusion Paint, double-click on the Fusion Paint
program icon. In a few seconds, the Fusion Paint startup
window will be displayed. If a system requester comes up
before this happens, insert the Workbench disk in one of the
drives.

If your computer has only a single drive, the system requester
may appear several times during the first run of Fusion
Paint. If Fusion Paint is used again before turning your
computer off, the system requester will not appear as often.

The Startup window displays the dimensions of the screen and
page you will be using along with the number of colors you will
have available.

Click on the Start button and Fusion Paint will load the
current default configuration which is a 32 color, low
resolution page displayed on a low resolution screen. A 32
color screen, which is 320 pixels wide and 200 pixels high, will
be displayed. Fusion Paint is capable of working in a variety
of graphics modes. By defining large page sizes which use
many colors, one runs the risk of not having the required
memory available to run the program.

If you do not have enough memory to start with this
configuration, reduce the number of colors by clicking on the
color entry field.



Close Window
Button

Title Bar

Operational Overview

Nearly all the input Fusion Paint needs comes from the mouse
pointer on the screen. This is due to the fact that all frequently
used operations are accessible through the icon interface.

The close window button is located at the top, left-hand corner.
Click on it to exit Fusion Paint.

Extending across the top of the screen is the Title Bar. The
program's name and the title of the current project are
displayed here. If the current project is unnamed, "Untitled"
will be displayed.

I Fusion

l
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FIGURE 1 - Icon interface

Freehand - used for painting freehand and line images
Boxes - used for painting rectangular objects

Circles- for drawing circles, ellipses, and curves
Airbrush - gives an airbrush effect

Brush - used to brush or paste small pictures (cuts)

Fill - for filling an area with a solid color or pattern
Magnify - for detailed editing

Text - used to enter and position one line of text (up to 80
characters

Fonts - selects the desired font

R N

©
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Drag Bar

Palette Bar

Depth Arranging

Gadgets

Pen Colors

84 Fusion Paint

10. Cut - used to copy areas of the main painting into Fusion
Paint's Cut Clipboard for use as brushes

11. Effects - allows the quick manipulation of cuts in effects
various ways

12. Erase - erases selected areas or an entire page

13. Palette - allows you to change colors in the palette bar

14. Printer - used to print the document

Immediately above the Title bar, and extending across the
screen is the screen's Drag Bar. If you click on this and hold
down the left mouse selection button while moving the mouse,
you can slide the screen up and down. This reveals the
Workbench and any other open screens beneath the Fusion
Paint screen. This allows other programs to be executed while
Fusion Paint is running.

Below the Title Bar and extending all the way across the
screen is the Palette Bar. The Palette Bar displays all of the
various colors available. To select a color, click on the
appropriate colored rectangle. If Fusion Paint is started with
fewer colors, the Palette Bar will not be extended as far across
the screen.

In the top right corner of the screen are the four standard depth
arranging gadgets (two for the Fusion Paint screen and two
for the Fusion Paint window). Click on them by clicking at
the top edge of the screen on the uppermost pixel. Use the screen
gadgets to get back to the Workbench so that you can start other
programs.

Proceeding down the right-hand edge of the Fusion Paint
screen brings you to two more colored squares which are the
pen colors. These serve to display the current colors of the
background and foreground pens. (It may appear that there is
only one box here because the background pen is the same color
as the rest of the screen's background.) To select a new color
for the foreground pen click on the desired color in the Palette
Bar. To select a new color for the background pen, click on the
Palette Bar while holding down a Shift key.



Main Tool Bar

Control Panel
Area

Scroll Arrows

Zoom Lens

The area below the pen colors is the Main Tool Bar that runs
along the right edge of the screen. This bar contains 14 tools.
Select a tool by clicking on its icon. When the tool is selected,
the colors of its icon will be reversed to show that it has been
selected. The Control Panel that is associated with the selected
tool will be displayed below the main tool bar.

The area below the Main Tool Bar is reserved for the Control
Panel. This area is used to display the various extra controls
that are needed by the different tools in the Main Tool Bar.
Upon entering the program, this area is blank because to
execute a function, the appropriate tool in the Main Tool Bar
must be selected.

Note: The mode last selected within a tool's Control Panel before
exiting that tool will be the current setting when the tool is used again.

In the bottom right-hand corner are the Scroll Arrows. These
four arrows are used to position the page on which you are
painting in the window. To demonstrate their use, first go
over to the Freehand tool (in the top right corner), select it and
doodle a bit in the window. Now that there is something
visible, the effect of scrolling can be seen by clicking on the
Scroll Arrows. Clicking once will move the screen slightly
(about four pixels). While the mouse's select button is held
down on one of the arrows, the screen will continue to scroll.
With larger pages, it may be necessary to use the rapid scroll
and full scroll options. To scroll rapidly through the picture,
hold down the Shift key on the left-hand side of the keyboard
while you click on a Scroll Arrow. To scroll all the way to the
edge of the page, hold down the Ctrl key while clicking on an
arrow.

Move the mouse pointer back into the main drawing area and
sketch a bit more. While continuing to sketch, press the right
mouse button (the one that is usually used for menus) and look
at the Scroll Arrows. While the menu button is pressed, the
Scroll arrows are replaced by an expanded view (called the
Zoom Lens) of the pixels surrounding the mouse pointer tip.
The exact pixel coordinates of the pointer are displayed on the
Title Bar. The mouse pointer will slow down to make precise
positioning easier. Any time the mouse pointer is below the
Title Bar (where it accesses the menus), the pop up Zoom Lens
can be accessed for precise alignment work.
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Preferences Menu Appears active only while the Startup window is visible on
Workbench screen. Fusion Paint is shipped with the program
default set to Load Program-All. To get the program to load
slightly faster, set this item to Load Program-As Needed. If
this item is selected, each tool will be loaded into memory the
first time it is accessed. Be sure to choose Make Permanent
from the Preferences menu before pressing start on the Startup
window. Whatever option you chose will remain as the
default from that point on until changed again.

Pull-Down Menus The pull-down menus may be accessed by first moving the
mouse pointer to the Title Bar, then depressing the menu with
the right mouse button. There are five columns of menus. The
first column is the Project menu. The second column, the
Modes menu, contains various tool modes. The third is the
Undo menu. It contains operations which are associated with
the concept of multiple undos.
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Via the Fusion
Paint Icon

QUICK TUTORIAL

To illustrate Fusion Paint, draw a doodle. Move the mouse to
the top right corner of the screen and click on the Freehand tool
icon there. The icon will be highlighted to show its selection
and the blank area below the main tool bar will display a new
Control Panel. This is the Control Panel for the Freehand
tool. Now move the mouse pointer to the middle of the screen
and sketch by holding down the left mouse button and moving
the mouse.

The color of the pen in use can be changed by clicking on one
of the colored rectangles at the top of the screen in the Palette
Bar. To draw straight lines instead of free hand sketching,
click on the Sloped Line icon beside the Freehand icon at the
upper right of the Control Panel. Click once to anchor one end
of the line and after moving the mouse a short distance to the
right of the first click, click again to anchor the second end of
the line.

Note: Ifyou pressa Shift key and move the mouse before the second
mouse click, you can relocate the image being created before
anchoring it to the screen.

Remember that the major tool icons are those that run across
the right edge of the screen. When one of these is selected an
additional set of sub tools are displayed as the Control Panel
below the major tool icons.

Starting Fusion Paint

There are four ways to get Fusion Paint running. The first is
to double-click on the Fusion Paint icon with the left mouse
button. This will bring up Fusion Paint without loading a
project (picture). Cuts (brushes) can be loaded automatically
by specifications set in the Tool Types line of the Info tool of the
Fusion Paint icon.
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Via a Project Icon The second way to execute Fusion Paint is by double-clicking
on the icon of a project that was created with Fusion Paint.
This will start Fusion Paint and automatically load any
default cuts listed in the info window into the Fusion Paint
Clipboard. Finally, the project that was double-clicked on will
be loaded into Fusion Paint.

Fusion Paint may also be invoked by single-clicking on the
project's icon. Then, while holding down the Shift key,
double-click on the Fusion Paint icon. When the Startup
windowappears, push the Start Button. The screen and page
size will be defined as previously saved for the loaded project.

An IFF file which was not created with Fusion Paint can be
automatically invoked by double-clicking on its icon if the
following changes are first made.

Each project has a Default tool associated with it. To change
this default, single-click on the project's icon, select the Info
item from the Workbench menu, and a new window will
appear on the screen which displays various aspects of the
project. Find the Default tool entry in this window to be used to
edit this project. Click in this gadget and change the Default
tool's name to "Fusion:Fusion" (if you are operating Fusion
Paint from the floppy disk) and hit the Return key. There is
also an entry that describes the stack size to be used with the
program, it is recommended that this be set to 8000 bytes.

Another way to convert the icon of an IFF image created in a
program other than Fusion Paint is to start Fusion Paint, then
open the desired image and choose Save As from the Project
menu. The image will then bear Fusion Paint' icon for IFF
images rather than the one it had originally.

Via the CLI Fusion Paint can also be started from the CLI by typing one of
the following:

Fusion:Fusion (assumes Fusion Paint is on the Fusion
Paint disk)

Fusion:Fusion -i (Start an iconized copy of Fusion Paint)
Fusion:Fusion MyPicture (loads MyPicture, Startup
window bypassed)
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Default
Parameters

ScreenWidth and
Height

The Fusion Paint master disk may be used as the Workbench
disk when booting the system.

The Startup Window

Upon executing Fusion Paint the Startup window will appear
on the Workbench screen (unless the default has been changed
via the Preferences menu discussed in "The Preferences
Menu" section of the Reference Manual). These are the
screen width and height, the Page (Edit) width and height, and
the number of colors in the palette.

The Startup window obtains its default parameters from two
places.

1. The parameters are initially set to a 320 by 200 screen, a
320 by 200 page, 32 colors, and overlays on. These may be
changed by saving different settings for these parameters
within the Preferences menu that is visible only while the
Startup window is active.

2. Secondly, if a project is chosen to be loaded in at the start,
the parameters are adjusted to suit that painting. That is,
the exact dimensions and screen resolution of the picture
are displayed. The Startup window also prevents the
entering of inconsistent values. For example, a screen
size which is larger than the current page size is not
allowed. Also the settings of 32 and 64 colors are not an
option with a 640 pixel wide screen.

The screen width is normally either 320 or 640 pixels wide.
However, Fusion Paint can make use of the extra width
available because of overscan on some monitors. The
oversized screen capability can allow you to have an editing
screen up to 704 pixels wide and 470 pixels high which is a 29%
larger editing surface.

Fusion Paint supports both the NTSC (North America) and
PAL (European) standards because it allows you to define the
exact screen size desired. The screen height is normally
either 200 or 400 lines in North America (NTSC). In Europe
256 or 512 lines (PAL) can be used. Fusion Paint can make
use of this overscan area that the Amiga can generate.
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Edit Width and
Height

Open - Picture

Open - Icon

90

Fusion Paint

The first four default size gadgets are the 320, 200, 640, and 400
buttons. These are used to select various standard Amiga
screen sizes. For example, the Workbench screen can be
either 640 x 200 or 640 x 400. The next two gadgets select the
European PAL screen heights of either 256 or 512. The final
four gadgets select the Amiga's normal (for NTSC video)
Overscan sizes of 352 x 220 for low res and 704 x 440 for high-
res. It is possible to have screen sizes even larger than these
(referred to by some as severe Overscan), but this is not
recommended for normal editing. It is recommended that a
normal screen size be used, but if a large Overscan area is
needed for some application, it's best to use a page size that is
larger than the screen size.

The size and number of colors in a picture that Fusion Paint
can edit is limited by the amount of available Chip RAM.

Opening and Saving

The Project menu contains the following options: Open, Save
As, Save Quick, Save Palette, About and Quit. The About item
can be used to determine the version number of Fusion Paint.
If a bug in Fusion Paint is found, this is the version number
that should be reported. The Open and Save items are used to
direct Fusion Paint to load a project for editing or to save the
current project to disk. These two modes also make use of the
settings in the Disk item of the Modes menu.

The Open-Picture is used to load a standard IFF graphic
image. Two additional options located in the Modes menu
under Disk are Use Page Size and Transparent which also
may affect the loading of picture files.

The Open-Icon feature is used to bring the graphic images
from a Workbench icon into Fusion Paint for editing.
WorkBench icons are not IFF standard graphics. They have
a special format so they must be loaded into Fusion Paint
using this command. Icons can be saved from Fusion Paint
as well. However, the icon will still need to be attached to the
proper type of file.



The Project Menu

Once the Open-Icon menu item has been selected, you must
click twice with the left mouse button to indicate to Fusion
Paint where to put the icon's image on the current Edit page.
The standard File requester will then appear. Enter or select
the name of the icon that you wish to load. WorkBench icons
are stored in files whose names always end with the
characters ".info". You may specify the icon by selecting
either the icon's name (i.e. Fusion.info) or by selecting the
name of the object which is associated with the icon (i.e.
Fusion Paint). Because of the way the File requester works, it
is usually best to just select the icon's true name (the one that
includes the ".info"). The icon's image will be loaded with its
upper left corner at the position indicated by the previous
double-click.

There are currently three distinct types of icons as well as the
usual types (Drawer, Garbage, Disk, Project, Tool, Kick, and
Device). An explanation of each of the three types follows:

1. Complement Highlighting. The icon changes its colors.
Complement Highlighting is characterized by
rectangular parts of the background surrounding the
object turning to orange.

2. Back-Filled Complementing. The icon changes its
colors, but the orange rectangular outline does not appear.
This can be a more pleasing effect.

3. Alternate Imaging. The image of the icon may
completely change to another image. This is termed the
Alternate Image mode and may be used to display
additional information such as "Don't click again!". It
could also be used to make an animation effect when
selected.

The Open-Icon function will load all three types of icon
images into Fusion Paint. The Complement and Back-Filled
Complement modes will both load a single image, and the
images will be identical if the icons appear that way in their
non-selected state. When an Alternate Image (animated)
icon is loaded, two images will appear, side by side. The
image on the left is the normal state, and the image on the
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Drawer
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right is the selected state for the icon. The images are placed
side by side so that they are in the correct format for saving to
disk as icons.

It is recommended that the icon be modified in the resolution
in which it will be displayed. Since the Workbench usually
has a resolution of 640 x 256 and 4 colors, icons which will be
displayed on the Workbench should be edited in Fusion Paint
in 640 x 256 and 4 colors.

Selecting this option from the Project menu will activate the
File requester in which you can open a drawer of cuts. This
feature allows you to create as many drawers as you like for
storing similar categories of clip-art. There's no need to
select a cut or file name when you select the drawer to load.
Just press the Ok button after the desired drawer has been
selected and all the cuts and IFF files will be loaded at once.

When this option is chosen, the current project will be saved
under a new name you specify in the File requester. The disk
options under the Modes menu called Use Page Size and
Transparent can affect the way a file is saved.

The Save As-Icon menu item is used to save a part of the
current picture as a WorkBench Project icon. Once this menu
item is selected, it is waiting for you to box an area to be saved.
Box the desired area that is to be saved as an icon. The File
requester will appear. Select the name to save the icon under
as usual, but do not include the ".info" in the name. The
reason for this is that Fusion Paint will create an icon with the
desired image as well as an IFF picture file containing the
IFF ILBM version of that image for future reference.

For example, when you select a file named "MylIcon", Fusion
Paint will save the boxed area as a mini-IFF picture file
called "MylIcon" and will make a WorkBench Project icon
with the same called "MylIcon.info". This allows the image of
the icon to be loaded into another program that does not load
WorkBench icon pictures but does load IFF pictures. When
the Save As-Icon feature is used, the icon will be saved in
Back-Fill Complement mode.



Save As-Alt Icon

Save Quick

The Save As-Alt Icon menu item is used to create Alternate
Image (animated) icons. It functions in the same way as the
Save As-Icon item just discussed. After selecting the menu
item, box the desired area to be saved as an icon. When the
File requester appears, select the name to save the icon under,
but do not include the ".info" in the name. Both an icon and
an IFF picture containing the same image are saved. It
differs from the Save As-Icon item by splitting the boxed area
in half vertically and saving the two halves as the two
alternate images to be used by the icon when it changes states.

Creating animated icons that line up correctly is actually
quite simple if a few construction guides are used. Start by
producing one of the two required images. Once completed to
the point that the size of the icon is established, make the image
a brush using the Cut tool. Select the Brush tool to paste down a
copy of the icon either to the left or right of the original image.
The image on the left is meant to be the normal state, and the
image on the right is the selected state. The second image
should be pasted down so that the two outline boxes just touch but
do not overlap. If the image has an outline, this will result in
the line separating the two images being two pixels wide.

When it is time to save the new icon, and an outline box
around the icon is desired, select the Save As-Alt Icon menu
item. Box the pair of icons including the outline. The
rubberband should be over the top of the outline to include the
outline but nothing outside of it.

If the outline is not to be part of the icon, erase the outlines
completely before saving the icon. You can also just erase the
double wide line dividing the two images. If this is done, use
the remaining outline to line up the rubberband box during the
save process by placing the Save As_Alt Icon rubberband just
inside the outline. This method will keep the two images in
perfect alignment, which is important for animated icons,
while not giving the icons a frame.

The Save Quick item allows saving of the current image while
bypassing the interaction with the File requester and the
Overwrite requester if the image has been saved previously. It
has the same subitems as the Save As menu item.
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The Save Quick menu allows a project to be resaved under the
same name without the need to use the File requester to select
the name and say "yes" to the "Do you want to overwrite?"
requester.

Save Quick will always appear disabled when Fusion Paint is
started. It will remain ghosted until the project is saved
manually using the Save As menu item. After the first save
has occurred, the Save Quick menu will be enabled,

indicating that the Save Quick option is now available. When
a Save Quick is performed, it will replace the file that was just
saved. Save Quick will now remain enabled until another
Open operation takes place. If Save Quick becomes disabled, it
will be reactivated when another Save As operation is
performed.

ARP File Requester

Once the File requester window opens up, one can start to
manipulate it without having to wait until the requester has
stopped listing the contents of the current directory. Simply
point and click with the mouse to make a selection.
Alternatively, you can double-click on any of the files for
access.

To get the list of disk drives and volumes currently installed,
press the right mouse button while the File requester is open.
When this is done, a list of all the disk drives and logical
assigns currently in the system will be appended to the
directory list area. Select the desired drive with the left mouse
button. If this is a long list, it may be scrolled in the normal
fashion to reveal any item in the list.

When a directory is selected, the files within will begin to be
listed. The Parent gadget can be used to "back up" one level of
the directory tree.

Finally, the desired file may be selected and the requester
exited by double-clicking on the file's name. A file name
may be entered from the keyboard by selecting the input gadget
near the bottom of the window and typing. If you do not wish to
access a file, click on the Cancel gadget.



ARP
Compatibility
with Other
Workbench Disks

The Palette Tool
and Palette Bar

The file "Arp.library”, contains the various support function
that ARP programs can call on. The version of this that is
needed for Fusion Paint is version 34 which is the library that
comes with the ARP 1.1 release. To install this new version of
ARP. LIBRARY onto your hard disk or workbench, simply
double-click on the "InstallArpLibrary" icon.

For those who have already switched over to using the ARP
DOS commands, there is no need to change the library file
unless it is an older version. For those who have not switched
over, you should consider doing so since ARP offers many
benefits in the CLI environment including smaller
commands (less disk space used), faster loading, and much
better usage of wild cards uniformly in all the commands.

Note: if you already have a copy of the Arplibrary file but you are not
sure which version, it is best to go ahead and copy the version from the
Fusion Paint master disk to the Workbench disks you'll be using. Be
sure the Arp.library file is in the 'libs"directory of the Workbench
disk from which you booted.

The Palette Bar

The Palette Bar runs across the top of the Fusion Paint screen
just below the Title Bar. This bar displays all of the currently
available colors in the system. To select a color from the
Palette Bar, click on the desired color. The Palette Bar is used
to select colors for both the foreground and background pens.
The current colors for these pens are shown just at the main
tools. To select a new foreground pen color, click on the

desired color in the Palette Bar. To select a new background
pen color, hold down a Shift key while clicking on the desired
color in the Palette Bar.

The palette can be used to change the background color
throughout the painting without having to erase the painting.
This can be executed by the following process:

¢  Select the Palette tool.

* Select the color on the Palette Bar which is being used as
the background color. This is the left-most color in the
Palette Bar.
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¢  Alter the slider bars to display the desired color.

To use 64 color mode, set the screen width to 320 pixels in the
Startup window. The screen height may be either 200 (low-res)
or 400 (high-res) lines. Using the Color gadget of the Startup
window, select 64 colors and select the Start button. The
Fusion Paint screen will appear essentially the same as in the
other color modes, with two exceptions. First the Palette Bar
will appear to be twice as thick as normal. The reason for this
is that there is only room for 32 color patches across the screen.
A second row has been added to bring the total to 64 colors. The
second difference is that the screen is slightly taller than
normal. This is so that the extra space needed by the palette
did not reduce the working window size.

The 64 color mode is slightly different from the other Amiga
graphics modes since some of the colors cannot be adjusted
independently. This becomes apparent when using the Palette
tool to adjust colors in the Palette Bar. When the mixer is used
to manipulate a color, both the color that is currently in the
foreground pen and the color in the Palette Bar directly above
or below it will change. The Amiga derives the colors in the
bottom row of the Palette Bar from the red, green, and blue
components of the colors in the top row. The bottom row of the
Palette Bar is half the brightness of the top row. For this
reason, the 64 color mode is called the Extra Half Brite mode.
To make the most effective use of the second row of the Palette
Bar, it is recommended that the top row be used to hold the
bright colors. The bottom row will thus automatically have a
set of darker shades available for use.

Fusion Paint has the capability of loading a custom palette
automatically during the startup phase. To save a new palette
as the default simply choose Save Palette from the Project
menu and the current color arrangement will be used as a
default for all projects using that same number of colors. A
separate palette can be established for each possible setting of
the number of colors in the Palette Bar.

The Title Bar

The Title Bar on the Fusion Paint screen has two functions. It
serves to display the name of the project that is currently being



edited, and it is the rubberbanding cancel gadget. Clicking
somewhere on the Title Bar cancels the rubberbanding of
lines, circles, and boxes, etc..

The Zcom Lens

If the mouse pointer is in the painting area (below the Title
Bar) and the right mouse button (menu button) is pressed, the
Scroll Arrows are replaced by an expanded view (called the
Zoom Lens) of the pixels surrounding the mouse pointer tip.
The exact pixel coordinates of the pointer are displayed on the
Title Bar.

Toggle On/Off Menus, Icons, and Mouse
Pointer

This feature allows you to turn off the menu bars, icons, and
mouse pointer for use in capturing video images and using
genlock devices. Due to some limitations, none of the
available tools are active at the same time the icons are turned
off. The F9 key toggles on/off the mouse pointer, and the F10
key toggles the menu bar and all tool icons. The mouse
pointer must be turned off before the icons if you want only the
picture to be visible.

Since it is possible to scroll the page to a position where there is
no painting surface under one set (or partially under one set)
of icons, a checker board pattern will be painted on the display
in areas where this occurs so the edge of the editing page is
obvious. If the screen size and the page size have the same
dimensions, there is only one position to which the page can be
scrolled so there will be no visible checkerboard when the
icons are turned off with F10. Since this position is quite
important, the Return key will automatically center the page.

When using an image with 64 colors, where the page and
screen size are the same dimensions, a small checkerboard
pattern will appear even when the image is centered. This is
unavoidable in all resolution regardless of the positioning of
the page due to how the system handles Extra Half Brite mode.
To avoid this problem of the checkerboard appearing when F10
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is selected and the image is centered, use a page size that is
slightly larger than the screen size by at least four pixels in the
vertical direction.

Auto Centering of Images

Due to the very large canvas size that can be used for painting
within Fusion Paint, and to avoid the limitations of the Toggle
On/Off icons, an auto-centering feature has been added. This
is executed simply by pressing the return key from within
Fusion Paint. It results in positioning the current Edit Page so
that it is perfectly centered within the screen regardless of
page size.

When used in conjunction with the other scrolling options, the
auto-center feature can provide additional maneuverability
around your page. For example to scroll immediately to the
middle of the right-hand side of the page, hit the Return key to
center the page and use the Ctrl key and the right scroll arrow
(key or gadget) combination to move to the right-hand side of
the page.

Rubberbanding

Many of the tools found in Fusion Paint make use of a
rubberbanding method. A rubberbanded form of lines,
circles, boxes and other figures is displayed before becoming
part of the painting. This results in the ability to manipulate
the figure into the precise form before its integration with the
picture. Rubberbanding is also used to define areas to fill,
load, save, print, and erase. These areas are defined with a
rubberbanded box.

While rubberbanding is in effect, icons in the Control Panel
on the right may be selected. This allows the changing of
modes during the given operation. The Scroll Arrows and
Cursor keys (which can be used to scroll) are also operational,
yielding the ability to draw figures or box areas which are
much larger than the screen size.



Rubberbanding
Boxes

Dragging of
Objects

Canceling the
Rubberband

Operation

ColorFont
Support

To rubberband a box, click where the upper left corner of the
box should be and pull the mouse down and to the right. The
left edge of a box can be moved by sliding the mouse pointer
past the left side of the box. Notice the box folds up and becomes
a line. Once the line is placed in the desired position, move the
mouse back to the right and the box will again be displayed.
The position of the top of the box can be altered in the same
manner. To move the entire box around the screen, hold down
a Shift key and move the mouse. Once the box is sized and
located correctly, click the left mouse button a second time to
place the box in effect.

The Freehand tool supports dragging of rubberbanded lines.
This works for both the general straight lines and the
constrained horizontal and vertical lines. As with boxes, the
selector that is used to activate dragging is a Shift key.
Holding down either Shift key while moving the mouse when
a line is being rubberbanded will cause it to be dragged rather
than rubberbanded. Therefore, once the length of the line is
correct, you may place it anywhere on the screen before
clicking to make it permanent on the screen.

While being rubberbanded a circle, ellipse, or curve, may be
moved about the page by holding down a Shift key and moving
the mouse. This is the same control sequence that is available
while rubberbanding rectangles, so it should prove quite
natural to use. With the Double Control Point Curve tool, the
left-Alt and Crtl keys control the two curves, leaving the Shift
keys free to be used for dragging the curve if so desired.

Any rubberbanding operation may be canceled by clicking
somewhere within the Title Bar at the top of the screen. This
includes operations concerning lines, circles, curves, and

boxed areas, etc..

Fusion Paint supports the ColorFonts' standard. Commodore
has announced that the official way of supporting ColorFonts
is the program called ColorText. ColorText is supplied by
Interactive Softworks for users of ColorFonts.
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Abort Function

An abort operation feature is available to stop time consuming
operations. To abort an operation, click in the small Message
window that is displayed in the middle of the screen.

Multiple Undos

To illustrate the Undo process, select the Boxes tool and draw a
number of filled and hollow boxes. Once these have been
painted, select Undo from the menu bar. The last box to be
painted will disappear. Each time you select this function,
another box will re-appear.Anything that can be undone can
also be redone.

At the present time there are two major limits: the total
amount of memory present (both Chip and Fast RAM
combined) and the amount of Chip RAM present. The amount
of free Chip RAM restricts the maximum size of the last
operation that can be undone while the total amount of free
memory and the number set in the Preferences Menu are the
only limit on the number of levels to the undo feature.

Since the Undo capability is so important, there are several
ways in which it may be accessed. One method is via the Undo
menu. Also, there are two keys on the keyboard that can also
be used to operate the single element undos and reverse undos.
These are the Esc and Help keys. Each time one of these is
pressed, a single undo will occur. As with the Undo icon, if a
Shift key is held down when either Esc or Help is pressed, a
reverse undo will be done. This allows you to rest one hand on
the keyboard to control undos quickly and the other on the
mouse to do the painting.

The Undo menu is an important part of undos. Undos may be
flushed from memory and enabled or disabled. The menu
items available are individually discussed in "The Undo
Menu" portion of the Reference Manual.



Using Undos in
the Brush tool

Apparent Loss of
the Undos

While using the Brush tool, a special type of automatic mark is
placed at the beginning of the first brush operation which will
not allow undo to be performed on operations which were done
previous to entering the Brush mode. This will appear as a
limitation, but you may continue to undo any previous

-operations simply by exiting the Brush mode and pressing

Undo. Also, the earliest operation done in this mode cannot be
undone without exiting the Brush mode. Once you have exited
the Brush mode, all operations done there may be undone as
usual. As a general rule, it's best to get into the habit of exiting
the Brush mode to perform an Undo. This will avoid any
confusion as to what is actually happening.

When you have the undo buffer set to a number of levels that is
larger than your Amiga can handle (that is, you are receiving
frequent out of memory flashes), it can appear to cause the loss
of your undos while not releasing the memory used to store
them. When this happens, the undos are not actually lost, but
you are at such a point that there is not enough free memory to
restore even one undo.

When this occurs, you have several options. The first is to try
to partially flush the undo buffer either with the pull-down
menu or the keyboard equivalent sequences for "Flush 1/8" or
"Flush 1/4", etc.. Secondly, you can continue to perform
small painting operation on the page which will eventually
force the earlier undos stored in memory to be deleted making
room for the later ones. If these earlier ones are larger than
the later ones, this exercise of doing small painting operations
will free up some memory, making it again possible to
activate the undos.

Loading Default Cuts

There is a feature that is useful for using various cuts, brushes
and patterns for artwork. Cuts can be automatically loaded
when Fusion Paint is booted. There are two ways to specify
that Fusion Paint should load one or more cuts upon startup.
Both of them involve the use of the Workbench Info program
accessible from the Workbench menu. The two ways for
doing this are:
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1. Changing the Tool Types information for the Fusion
Paint program icon.

2. Changing the Tool Types information for any IFF project

icon created with Fusion Paint.

The Info item accessible from the Workbench menu allows
you to specify any number of cuts that may be loaded
automatically upon startup of Fusion Paint. To specify that
cuts be loaded do the following:

1. Select the Fusion Paint icon with the left mouse button
(single-click).

2. Choose the Info option from the Workbench menu.

3. Press "Add" in the lower right corner of the Tool Types
area.

4. Type CUTDRAWER-= followed by the path name for the

desired cut to be loaded, separating each different layer of

directories by a backslash. For example, the entry

CUTDRAWER=Fusion: Corner.Cuts/Cornerl would load

the cut "Cornerl" from the Corner.Cuts drawer of the
Fusion Paint disk if it resided there. The path name

conventions used are the same as that for Workbench 1.3.

For example, the entry

CUTDRAWER=Art:Mycuts/*.box | ram:Clipart/cuts/* | d
hO0:*.cut? would load all the cuts which ended with .box in

the Mycuts drawer on the "Art" disk, all the cuts in the
cuts drawer of the Clipart drawer in the rem:device, and
any cuts in the root directory of the hard disk partition
dhO: which ended with ".cut" and any other single
character.

5. Hit the Return key after the path name is entered.
6. Press Save to leave the Info program.

Repeat steps 3 through 5 for each different cut drawer to be
loaded automatically upon startup.



Method Two

Library
Applications

The second method is the same as the first explained above
except rather than selecting the Fusion Paint program icon
before choosing the Info program from the Workbench, select
the IFF image file you would like to be loaded along with the
cut drawers you want to work on with that image. This method
allows you to attach the loading of certain cut drawers to the
appropriate image.

Symbol and Brush Libraries

In the previous section, two methods for specifying cuts to be
loaded into the Cut Clipboard when Fusion Paint start up were
described. Since a cut may contain just about any image one
can draw, from a single pixel to an entire screen size picture,
these auto-load features can be used to implement symbol and
brush libraries.

Since you can also simply choose the Open-Cut Drawer option
to load an entire drawer of cuts at once within Fusion Paint,
you can easily maintain and work with related categories of
clip-art.

Placing related cuts in a library in the same drawer or set of
drawers on a separate data disk is the recommended way of
organization. When loading these cuts automatically,
through the use of the Info tool specifier, use the disk name as
the device designation. (The device designation is the one
followed by a colon.)
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The Project Menu

The project menu contains the following options: Open, Save
As, Save Quick, Save Palette, About, and Quit. The Open and
Save item are used to direct Fusion Paint to load a project for
editing or to save the Current project to disk. These two modes
also make use of the settings in the Disk item of the Modes
menu.

The Modes Menu

The Disk item of the Modes Menu has two option. The first of
these modes, the Use Page Size option, exists to address the
problems with editing full screen overscanned images. The
second option, Transparent, was added to allow special
masking and overlay effects with the Open and Save features.

When Use Page Size is not checked (the default), Fusion Paint
will save the current screen size as defined in the Startup
window. This is what Fusion Paint has always done. When
the Use Page Size item is checked, Fusion Paint will save the
current Edit Page size for the viewable document size. Thus,
to save the image as overscanned, set the Edit Page size to
overscan dimensions. This allows one to edit on a normal
screen size, yet allows an animation or video titling program
to display the full Edit Page area.

When this option is selected before a save is executed, Fusion
Paint will flag the current background color as being
transparent when the picture is saved. (The current
background color is not necessarily the left-most color in the
palette, color zero.) This will allow you to specify that this
image could be later opened and merged with another file
without the background color of one blotting out the other. That
is, the background is transparent.

Once a file has been saved with background transparency
enabled, there must be some way of disabling this feature
when the picture is being loaded and transparency is not
desired. To disable transparency on loading, make certain
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that the transparency item is not selected before the load takes
place. Conversely, then the transparency item is checked and
a picture that has transparency enabled is loaded, it will not
change the portions of the current page where the incoming
picture is transparent.

To pick the color off of an image using the Modes pull-down
menu, simply choose Pick Color. Place the mouse pointer
directly over the pixel or pixels of the desired color and click
once with the left mouse button. If needed, you may press the
right mouse button to see the zoom view in the lower right-hand
corner of the screen. This is helpful if the color takes up a very
small space or is adjacent to another color of a similar shade.
By pressing the Shift key while picking a color, it will be
selected as the current background color rather than the
foreground color. The F1 key is the keyboard equivalent for
the Pick Color function.

The Color Brush item in the Modes menu is used to change the
color of the current brush (cut) to that of the foreground pen.
The recoloring process works by taking all the opaque regions
of the brush and replacing their colors with the current
foreground pen color. All colors of the brush apart from the
background color will be replaced by the foreground color
creating a silhouette of the brush. This feature can be useful
for shadowing brushes. You may want to use it in conjunction
with the Power Borders feature of the Boxes tool.

Fusion Paint supports up to six ranges of color cycling, both
within Fusion Paint and in IFF Picture display programs that
support color cycling through the IFF standard for color
cycling information exchange. The color cycling system is
controlled through four keys, four menu items, and one
control window. By choosing the Color Cycle option or its
keyboard equivalent, the Tab key, color cycling will be
activated according to the parameters set in the Set Cycles
window.

There are two ways to access this window. It can be made
active either from the Set Cycles menu item in the Modes menu
or by pressing the Shift and Tab keys together. The window
consists of several regions which are discussed in the
following paragraphs.



In the upper left corner is the Close Window gadget which is
used to close the Set Cycles window and return to Fusion
Paint's edit mode.

The Rate Slider (just below the Close Window gadget) is used
to set the speed of color cycling of one cycle range at a time. At
its topmost setting a given cycle is effectively turned off, and
at its bottom most setting the fastest cycling rate is achieved.

The maximum cycle rate is 30Hz, which means that every
1/30th of a second the cycle will make one step. Thus, with a
color range of six colors, it would only take 1/5th of a second to
cycle through the entire range. The minimum cycle rate is
less that 1Hz, which means that it takes more than one secorid
for a single step in the cycle to take place.

In the middle portion of the Set Cycles window are a number of
gadgets that control which cycle range is being adjusted. Six
independent color cycle ranges are available. These are
selected by clicking on the gadgets marked R1, R2, R3, R4, RS,
and R6. Each time a different range is selected, the rest of the
Set Cycles window is updated to reflect the current settings of
that range.

Above the range selection area are two additional gadgets
which determine the current cycling mode. The top one
controls whether the currently selected range will be active or
not. When this gadget is highlighted, the current range is
activated and will be used when the user turns color cycling
on. This is an additional control over the Rate Slider's top
most position. It is very useful when one is fine tuning color
cycling and needs to disable a range or two temporarily
without changing the rate settings. Below the active gadget is
the reverse gadget. This controls whether the selected range
will be cycled forward or reverse. Highlighting this gadget
will reverse the direction of the color cycle.

In the right half of the Set Cycles window is an array of up to 64
colored rectangles (cells). Each of these rectangles is divided
into two square tiles with a blank rectangle appearing below.
This Palette Area is used to select which colors make up a
particular range. To define the lower limit of the range, click
in the left-hand portion of the desired color. To define the
upper limit, click in the right-hand portion of the desired
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color. As this is done, note that a dotted line moves about to
indicate the extent of the range and that the numeric range
displays change.

Note: Wi?nusing Extra Half Brite mode (64 colors), the range
settings of the first 32 colors must also be applied to the associated half
brite colors. That is, the color cycling will occur on both the desired
colors and their corresponding half brites.

The Single Step menu item in the Modes menu (or the F2
function key) causes color cyclingto advance one step and
stop. Color cycling remains halted until F2 is pressed again
(at which point the cycle advances one more step), or until Tab
is pressed (color cycling resumes). This Single Sep feature
can be used to freeze a cycling display, then step through it to
study the effect. Once the Single Step operation has been
executed the palette is changed to the current settings in the
color cycle. This means that you may actually edit or save
pictures in the intermediate stages of a color cycle.

Since the palette is changed to the current settings of color
cycling, when the Single Step feature is being used, the Reset
Cycles menu item is provided in the Modes menu. It allows
you to reset the palette back to its state before color cycling was
initiated. This must be done before using the Palette tool,

since this operation makes the cycled state permanent. The F3
key is the keyboard equivalent of the Reset Cycles menu item.

The Grab Screen feature in Fusion Paint is very unique in
that it may be activated while within the program and once the
choose screen is "grabbed” Fusion Paint automatically
becomes active again containing the image. Furthermore,
you may even chosen a pull-down menu from another screen
before the "snapshot” is taken.

To grab another screen simply choose Grab Screen. A
requester will appear telling you to activate the screen to be
taken in ten seconds. After responding with "Yes" you must
go immediately to the screen you want to take a snapshot of
and make it the front most one using the depth arranging
gadgets in the upper right corner of the screen. When only
four seconds remain before the snapshot is to occur, the display
will flash. After these four seconds go by, the display will
flash again indicating the snapshot was taken. Fusion Paint




Change Screen

Iconize

will automatically become the front most and active screen
and will contain a snapshot of the screen you just took.

This option allows you to change the screen resolution, page
size or number of colors on the fly from within Fusion Paint.
It also allows the Preference menu to become active which
allows you to set several default setting.

After choosing Change Screen a requester will ask "Ok to
delete cuts and change screen?'. By pressing the "Yes"
button, you will see the same Startup window that usually
comes up when Fusion Paint is executed. Simply make the
desired changed and press Start. If the number of colors was
reduced, you will be asked whether or not you want Fusion
Paint to intelligently recolor the image using the new color
settings. Since this process attempts to build a new palette
designed to least affect the reduced color picture, you will
usually want to respond with "Yes" if an image is open in the
program,

When Change Screen is chosen, the first thing that Fusion
Paint will attempt to do is to allocate memory for a backup of
the current picture. If Fusion Paint is unsuccessful at this, a
second prompt will be displayed asking if it is safe to delete the
picture. Although cuts are always deleted upon changing
screens, the picture will only be deleted if you respond with
"Yes" to this second question.

Selecting the Iconize item from the Modes menu will cause the
current Fusion Paint edit session to be suspended. The
current project and cuts are stored in memory, but as much
Chip RAM as possible is freed up while Fusion Paint is
iconized. This mode is useful when multitasking with other
programs that need access to a lot of Chip RAM. To restore the
iconized Fusion Paint back to its original state, make the
iconized window active with the left mouse button then click
anywhere in its Title Bar with the right mouse button.
Iconization will only succeed if there is enough free memory
left in the system to make a backup copy of the picture before the
screen is closed.
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The Undo Menu

Undos may be flushed from memory and enabled or disabled.

Allows the user to undo a selected item and then "bring it
back."

There are two Undo menu items that will do multiple undos in
one command. These are the Goto Oldest Undos and Goto
Newest Undos items. These are provided for convenience in
reviewing the complete undo buffer. By selecting Goto Oldest,
you will be returned to the point before any painting was done
since an automatic mark is always placed there. Selecting
Goto Newest will return you to the latest point in the editing
process.

The Flush item has four subitems each allowing you to
selectively delete portion or all of the undo buffer to free up
memory. "Flush All" will purge the entire undo buffer. The
keyboard equivalent to the Flush menu item is to hold down the
left-Alt key, left-Shift, and Ctrl keys while pressing either the
Esc or Help keys. This is intended to be a two-handed
operation, thereby preventing accidental flushing of the undo
buffer.

In order to allow only partial deletion of the undo buffer,
several other options are available. "Flush 1/8" allows you to
delete one eighth of the current undo buffer starting with the
oldest undo first. "Flush 1/4" deletes the oldest one fourth of
the buffer and "Flush 1/2" deletes the oldest one half. One of
these options should be selected when the screen flashes
indicating you are low on memory.

The Preferences Menu

The Preferences menu, which can be used to configure certain
default startup settings for Fusion Paint, is only accessible
when the Startup window is displayed. The four items that this
menu has for establishing default settings are Load Program,
Undo Buffer, Auto Start, and Default Tool. The Make



Load Program

Undo Buffer

Auto Start

Default Tool

Permanent menu item will cause these default values to be
saved to disk.

Two options (All and As Needed) are currently supported in
the Load Program menu item. Selecting All will cause
Fusion Paint to load its entire program into RAM at startup.
As Needed will initially load only part of the program and the
code for new tools is loaded into memory when they are first
accessed. The major difference here is that the As Needed
setting will start noticeable faster when run from a floppy
disk. Users of a single drive floppy disk system should use
All, since the disk will not be accessed each time a tool is
selected for the first time.

This menu item is used to specify the number of undo levels
that Fusion Paint should provide. The important things to
balance here are the benefits that a large number of undos
provide against the memory costs of these undos. For more
information on undos and recommended settings to use, see
"The Undo Menu" section in Chapter One of the Reference
Manual and the "Multiple Undos" section in Chapter Three of
the User's Manual.

The third menu item controls the AutoStart feature. Thisis a
great convenience for those who use primarily one editing
configuration. When "Yes" is selected Fusion Paint will not
bring up the Startup window during the startup phase. Fusion
Paint will be configured to the last saved screen and page sizes
and the edit window opened automatically. The Make
Permanent menu item saves the current Preference menu
settings and the Startup window settings.

The fourth menu item is of interest to WorkBench users who
have customized their Amigas to some extent. The current
selection of this menu item is used as the Default tool
whenever Fusion Paint saves a project or cut and creates an
icon for it. Four possible tool names, from which the most
useful one may be chosen, are accessible.

The first "Fusion" is used when Fusion Paint is stored on the
disk in the same drawer as the various pictures. The second
"Fusion:Fusion" is the default setting and is useful either
when Fusion Paint is stored on a disk called "Fusion" (this is
how the master disk is set up), or when Fusion Paint is stored
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in a directory to which the logical name "Fusion:" has been
assigned with the Amiga DOS "Assign" command (this can
be useful for hard disk owners). The third setting
("C:Fusion" is useful for those who wish to put Fusion Paint
into their command directory. And the fourth (":Fusion") is
useful when a user wishes to put one copy of Fusion Paint on
each working project disk.

The Make Permanent menu item will cause the current
Preferences settings and Startup window values to be saved to
disk. These defaults will be saved in a file called
"Fusion.config" in the "S:" drawer (the same place the
Startup-Sequence file is located). Note that since this file is
often located on the boot disk, it may be necessary to
temporarily remove the write protection on that disk to allow
the file to be written.

This ability is very useful for those who work a lot in one
particular resolution since doing so will cause Fusion Paint to
start automatically in the desired resolution saving time
during startup. Just be sure that the desired screen height and
width, page height and width, and number of colors are set
before selecting Make Permanent.

If for some reason the Fusion.config file gets corrupted or set
into a configuration in which Fusion Paint cannot start (for
example Auto Start-Yes selected and a very large screen size
specified), delete the configuration file from the "S:" directory
to reset everything. To accomplish this, use the CLI
command:

Delete S:Fusion.config

The Freehand Tool

The Freehand tool is used to paint various types of line
graphics. The Freehand tool's Control Panel, displayed on the
right-hand side, shows the icons for the three main line
painting modes. These are the Freehand Sketch mode, the
rubberbanded Straight line mode, and the Rubberbanded
Horizontal and Vertical Line mode.



Freehand Sketch
Mode

Rubberbanded
Straight Line
Mode

Cancel
Rubberbanding
Mode

Rubberbanded
Horizontal and
Vertical Line
Mode

The Freehand Sketch mode, is very easy to use. Click on its
icon. To paint, hold the left mouse button down while moving
the mouse. The Freehand mode is often used to rapidly sketch
out a figure.

The General Rubberbanded Line mode is somewhat more
complicated. After selecting this (Straight Line) mode, click
once to set the first end point. When the mouse is moved, a
straight line between this point and the current mouse position
will be rubberbanded. While rubberbanding a line, it is
possible to scroll the page to paint long lines. To set the second
end point, click a second time in the painting.

To stop the rubberbanding without painting anything
permanently in the picture, make use of the general cancel
rubberband feature. To cancel any rubberbanding operation
that must be aborted, move the mouse up to the top of the screen
and click somewhere in the Title Bar area. The line can be
dragged anywhere on the screen before setting the second end
point, by holding down the Shift key and moving the mouse.

Horizontal and Vertical Rubberbanding works in the same
fashion as the general rubberbanding method just described.
However, the program forces the line to be horizontal or
vertical. The direction that the line runs is determined by the
direction (horizontally or vertically) in which the mouse
pointer has been moved the most from the starting point of the
line.

The Boxes Tool

The second icon at the right of the screen in the Main Tool Bar
is the Boxes tool. This is the tool to use to paint or fill
rectangular regions. The Boxes tool Control Panel appears on
the right-hand side of the screen as usual.

Reference Manual 113



Cut Selection
Arrows

Hollow Box Mode

114

Fusion Paint

The Boxes tool is the first tool so far to have the Cut Selection
Arrows in its Control Panel. These are the arrows appearing
at the top of the Control Panel. They are used to scroll through
the Cut Clipboard list. The first time the Boxes tool is selected
you will probably not see any cuts displayed. However, if any
cuts (brushes) are available on the Clipboard, clicking on one
of these arrows will cause one to appear. The cut will be
displayed on a window of its own in the top left-hand corner of
the screen. Cuts can be used for a number of applications
including patterned area filling and brushing. Below the Cut
Selection Arrows are the mode selection buttons. The four
available modes are: Hollow Box, Solid Box, Patterned Box,
and Complemented mode.

Clicking on the Hollow Boxes icon will activate the Hollow
Box Painting mode and will serve to illustrate how
rubberbanding of a rectangular area works throughout the
program. Move the mouse pointer to somewhere within the
current area of view and click to set the upper left-hand corner
of the box. Now, pull the pointer towards the bottom right-hand
corner of the screen. As the pointer is moved, a box will stretch
down and to the right. 1o demonstrate rubberbanding of
rectangles, move the mouse pointer to the left, past the initial
left edge of the box and observe what happens The box folds up
and becomes a line. It then pushes the left edge along with it.
As one can readily verify, this "pushing” effect also occurs on
the top edge of the box, if the pointer is moved up.

Now for another twist, move the mouse down and to the right a
bit so that a box is again displayed. Next, press the left Shift
key and hold it while moving the mouse in a circle. This has
the effect of keeping the box at a fixed size while it is moved to
the desired position. Finally, when the size and location of the
box are satisfactory, it can be painted in the current
foreground pen color by clicking a second time.

[NOTE: To cancel a rubberbanding option, click on the Title Bar.

]




Solid Mode

Pattern Mode

Complement
Mode

After selecting the Solid Boxes icon in the Control Panel,
rubberband the area to be filled. Upon the second click of the
left mouse button, the program will fill that rectangle with the
current foreground pen color. The foreground pen color is
changed by choosing the desired color with the mouse from the
Palette Bar. The current foreground pen color is displayed
just above the Control Panel.

If a cut is visible, when this mode is selected, the box you paint
will be filled with the pattern shown in the Cut window. This
mode allows you to take the cut that is currently displayed in
the Cut window and fill the rubberbanded rectangle with the
pattern. The filling process is executed in a globally aligned
sense. That is, if several areas are pattern filled with the
same pattern, the patterns will link up properly at the points the
areas overlap.

The Cut tool can be used to load or make more patterns for use
in this and other modes. The painting speed in this mode
depends on the size of the pattern in the Cut window. A smaller
pattern (tile) takes longer to fill any given area than a larger
tile does, but the larger tile takes up more memory.

To create a pattern in a rectangular area: select the Patterned
Boxes icon in the Control Panel, select the desired pattern by
clicking on the Cut Selection Arrows at the top of the Control
Panel, and box the area to be patterned using the rubberband
method.

The fourth mode of the Boxes tool is the Complement mode (the
icon with the layered squares). This mode, which is most
useful when producing black and white paintings, can be used
to highlight areas by "flipping” the pixel colors in the boxed
region. With a black and white painting, this mode can be
used to produce the reverse video effect. And with a color
painting, it can be used to produce some quite abstract
"negative image" effects.

To demonstrate the Complement mode: paint a solid box with
one of the dark colors in the Palette Bar, select the Complement
mode in the Control Panel, and rubberband a rectangle such
that it overlaps part of the solid box and observe the results.
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Power Borders are accessed through an Alt key which is held
down at the second mouse click of the Hollow Box and Pattern
modes of the Boxes tool. If the Hollow Box mode is currently
selected, a hollow border will be drawn based on the currently
displayed cut. If the Pattern mode is instead currently
selected, a solid filled border (again based on the current cut)
will be drawn.

Since Power Border patterns are kept in standard cuts,
changing the border pattern is as simple as selecting a
different cut. This approach allows custom borders to be easily
designed and used. The Fusion Paint disk comes with a
Borders drawer that contains sample cuts designed to be used
as Power Borders. After loading these cuts with the Open-Cut
Drawer item in the Project Menu, try creating borders with
them. While drawing Power Borders based on these
predefined cuts can be useful, you will want to be able to create
your own custom borders. For this reason, the details of how
Fusion Paint creates the border are given below.

Cutswhich can be broken into a 4 x 3 grid by Fusion Paint will
produce flaw-free borders. When Fusion Paint is about to use
a cut to draw a border, it looks at the cuts dimensions (width
and height) and from these determines if this border should be
treated as the 3 x 3 case previously described or as a specially
constructed 4 x 3 case.

The Circles Tool

Use this tool to paint circles, ellipses, and smooth curves. The
four major modes for this tool are the Circle mode, the Ellipse
mode, the Single Control Point Curve, and the Double Control
Point Curve.

Selecting this mode allows the ability to paint circles.

Clicking once sets the center point. Moving the mouse pointer
rubberbands the circle. Once the desired size is reached,
clicking a second time will paint the final version of the circle
in the current foreground pen color. Holding the Shift key
down while the circle is rubberbanded, allows it to be
repositioned with the mouse.



Ellipse Mode

Single Control
Point Curve

Double Control
Point Curve

This mode can be used to paint irregularly shaped images.
Use this option following the same method as the Circle mode
just described.

This mode can be used to connect two points by a smooth curve
that is not necessarily circular. The procedure for painting
such a curve is to select its icon in the Control Panel, click on
the two end points that the smooth curve is to join (a line will
appear between them), rubberband the curve with the mouse
pointer, and when the curve assumes the desired shape, click a
third time to paint it on the screen. While being rubberbanded,
the curve can be positioned with the mouse by holding down a
Shift key.

This mode is used when the need arises to join two lines with a
curve that blends smoothly into both lines or when other
complex curves are required. To use this mode, click on its
icon, click on the two end points, and adjust the shape of the two
curves by moving the mouse while holding down either the
Ctrl or the left-Alt keys. Pressing the Alt key while moving
the mouse specifies the slope of the curve at the first end point.
Pressing the Ctrl key specifies the slope at the second point.

The Airbrush Tool

Unlike the previous tools, The Control Panel for the Airbrush
tool consists of three sliders and two icons. The default
settings of the Airbrush tool allow the gun to operate in a
normal airbrushing mode that is common to nearly all paint
programs. The Airbrush tool deposits dots of paint in the
current foreground pen color.

Hold down the left mouse button while moving the mouse.
With the sliders, the width of the spray can be varied from a
single pixel up to about 100 pixels. There are two controls to
vary the width of the spray: a horizontal (X) and a vertical (Y)
width control. This allows the shape of the spray to be suited to
the shape of the area to be painted. The Density (D) slider
allows you to adjust how heavy the relative paint deposit will be
in a given area.
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The shape of the spray can be varied in another way. The two
icons at the top of the Control Panel allow you to select from a
rectangular and an elliptical spray pattern. The size of both
shapes of spray are fully adjustable in the horizontal and
vertical directions. The density (or rate) of spraying can be
varied with the D slider.

The Brush Tool

As can be deduced from the Control Panel's top two icons, the
Brush tool makes use of cuts as brushes. Click on the Cut
Selection Arrows at the top of the Control Panel to select the
brush to be used. Move the mouse pointer to the center of the
screen and hold down the mouse button to paint with the
current brush.

The Brush tool has two modes of operation. In the first,

holding down the left mouse button while moving the mouse
will leave a series of images behind. The Brush icon on the
left side of the Control Panel is designed for this operation and
is the default. By first cutting an image with the Cut tool, you
can paint with virtually any graphic which is smaller than the
screen. If you need to sketch an outline which is smaller than
one pixel wide, create a cut which is the desired size and use
this mode to sketch with it.

The Paste mode, which is activated by the icon on the right, sets
exactly one copy of the current brush on the painting of each
click made with the left mouse button. Because several cuts
may be in the Cut Clipboard at once, the Paste mode may be
used effectively in the assembly of many types of paintings
which have repeated symbols such as circuit diagrams, floor
plans or even organizational charts.

As you probably will have noticed by now, some regions of the
brush appear to be transparent. Any area of the brush that is
the same color as the background color, when the brush was
made, appears transparent.



The Cut
Clipboard

Lasso Cuts

Deleting Cuts

Loading Cuts

The Cut Tool

The Cut tool is used to make copies of parts of the painting for
use as brushes, fill patterns, Power Borders, or to perform
special effects.

Box or lasso the area to be copied. After the second click, a new
window will appear on the top left-hand corner displaying the
area that was just cut. All cuts are placed in the cut clipboard.

To see what is currently on the cut clipboard, scroll through the
cuts with the Cut Selection Arrows at the top of the Cut tools
Control Panel. There are four other icons in this Control
Panel.

To select the Lasso Cut mode rather than the normal
rectangular mode, click on the Lasso in the Cut Control Panel.
When in Lasso mode , the cut is made by depressing the left
mouse button at the start of the lasso, then dragging the mouse
pointer around the object (with the mouse button held down)
and releasing the button. T'he lasso will always be closed by a
straight line from the first point to the last point. This can be
useful for cutting when one edge of a cut follows a straight
edge.

The Trash Can icon is used to delete the current cut from the
Cut Clipboard. There is no way to recover a cut that has been
deleted with this Trash Can. Again, this process is very fast ,
so the only effect is that the cut window will either disappear or
a new cut will appear in it.

The next two icons are the Save (to disk) and the Load (from
disk) Cut icons. With the Save Cut icon, the currently
displayed cut may be saved to disk as an IFF image. With the
Load Cut icon a previously saved cut (or even a picture if
memory allows) may loaded into Fusion Paint's Cut
Clipboard. Either of these icons will immediately bring up the
file requester.

When a cut is saved to disk, the current color palette is saved
within the file. However, when a file is loaded from the disk
using the Cut tool's Load Cut function, any color palette
information is ignored. If this color palette is needed, the
loading must be done with the Open item in the Project menu.
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The Fill Tool

The Fill tool is a general purpose tool that allows area filling
to be applied with solid colors (selected by the Palette Bar) and
cuts. The Control Panel has four icons to accomplish this. At
the top there are two Cut Selection Arrows which allow you to
scroll through the cuts in the Clipboard. The two gadgets below
the Cut Selection Arrows select either solid color fills or
pattern fills. The current cut is used as fill material for
patterns.

The method of indicating the area to be filled works in the
same fashion with both of the area filling modes. First move
the mouse into the main painting area and box (rubberband) a
region that contains the area to be filled. Then click
somewhere within the actual area to be filled. This indicates
when to start the fill.

The Cut Selection Arrows work in the same way as previously
mentioned in the Boxes tool section. Simply press one of the
arrows until the desired cut is visible. The visible cut becomes
the current cut.

The Pattern Fill mode allows an area to be filled with the
currently selected cut. To demonstrate filling with a cut
follow this procedure. Using the Freehand tool paint a heart
shaped region. Return to the Fill tool. Using the Cut Selection
Arrows select a cut. Finally, box an area on the screen which
encloses the heart and click within the heart.

Effects(Fx) Tool

The Effects (Fx) tool manipulates cuts in two ways and is one
of the tools that does not directly affect the main canvas. All of
its work is with the cuts available on the Cut Clipboard.
Selecting the Effects tool brings up a Control Panel on the
right-hand side of the screen with four icons and a Cut window

in the top left corner of the screen if any cuts are in the
Clipboard.



Cut Stretch Tool

Cut Rotate Tool

The fist two Control Panel icons are used to scroll through the
Cut Clipboard. They operate the same way as the ones in the
Box, Fill, and Cut tools. Below these Cut Selectors, there are
two icons which take immediate effect on the currently
displayed cut. These icons and there functions are
subsequently examined.

Clicking on this tool icon will cause a rectangle, the same size
as the cut to be processed, to be displayed in the upper left
corner. Also, a rubberbanding rectangle will appear on the
screen attached to the mouse pointer. The rubberbanding
rectangle indicates the size of the stretched cut when the
stretching operation is complete. To resize the cut, move the
mouse so.that the rubberbanding rectangle is the desired size,
then click.

This icon can be used to rotate the current cut. To rotate a cut,
scroll through the Cut Clipboard until the proper cut is
displayed and click on the Rotate icon. A box which is the
same size as the cut to be rotated will appear near the center of
the screen. By moving the mouse, this box can be rotated to the
desired orientation. When the select button is clicked, the
actual rotation of the cut will begin. Depending on the size of
the cut to be rotated, this action can take anywhere from a few
seconds (for a small cut) to a minute for one near the size of the
screen.

To abort the rotation of large brushes before they have run their
course and finish normally, click in the small message
window that is displayed in the middle of the screen during the
operation.

Note: Both the stretching and rotating operations are irreversible.
For this reason, it is a good idea to make duplicate cuts of the same
image before experimenting with these operations.

The Text Tool

The Text tool is a line-oriented text placing tool which can be
used to put small amounts of text on the page very quickly.
Once text is placed in the desired position, the appearance and
location can be changed before being locked into position
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Entering Text To enter text:

¢ Click in the box, type in the desired information, and hit
the Return key. The text will appear in the painting near
the center of the screen.

* The Text can then be moved to the desired position by
either, clicking on the desired location, or by holding the
select button down and dragging it with the mouse. The
text will be rendered in a special painting mode called
"complement” which prevents the background from being
damaged as the text is moved around.

¢  When the text is in the correct position, hit the Checkmark
gadget to fix it in place.

Text may be altered at anytime before selecting the
Checkmark gadget. To edit text before hitting the Checkmark,
click in the text entry box and make the desired changes, then
hit the Return key.

When the Checkmark gadget is chosen, several operations
occur:

¢ The final version of the text is placed on the screen.

* The contents of the text entry box will be cleared.

¢ The text entry box is automatically activated so that the
next line of text can be immediately entered from the
keyboard without the need to select the text entry box.

* An automatic carriage return and line feed is printed so
that the next line of text will be placed below and left
aligned with the text above.

To leave this tool, click on the icon of the Stop button, in the
Control Panel. You must exit this tool in order to get access to
the other tools.

The Fonts Tool

This tool can be used to load any font that is currently in the
system for use in subsequent Text tool and operations. To use
this tool, activate it and click on the font name and size
displayed in the main window area. Then click on the Load
button (the from disk icon) to load the font into memory for
use. When the font has been loaded, the tool will close and the
normal screen will be restored.
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The Fonts Tool

Fusion Paint will look to the fonts directory of the boot disk to
obtain the list of fonts which will show up in the fonts tools
window. Therefore, one can have fonts other than those
supplied with the system (Workbench) disk available in
Fusion Paint. One method of getting Fusion Paint to see the
desired fonts is to copy them to the fonts directory of the system
disk. Use the CLI copy command to accomplish this. Another
solution is to force the software to look to another directory
which contains the desired fonts, rather than the standard
fonts directory. Once the font directory has been reassigned,
Fusion Paint's Fonts tool must be told to load the font list from
the new location. To accomplish this, hold down an alt key
while clicking on the Fonts tool icon in the Main Tool Bar.
Fusion Paint will then re-scan the disk and rebuild its font
list.

Another way of changing the fonts directory is to put all the
fonts in the root directories (the first level) of disks called
"FONTS." Then to use a particular set of fonts, put the
appropriate disk in a drive. Use the Alt key while clicking on
the Fonts tool to get Fusion Paint to scan the fonts when
needed.

The Magnify Tool

Upon selecting this tool, a small box will be under the control
of the mouse. Use this box to highlight the area in which to
work, then click the left mouse button. The outlined area will
be magnified on the screen. The foreground and background
pens may be changed and the Pick Color item in the Modes
menu can be used while in the Magnify mode. Most other tools
are inactive while in Magnify mode.

The Magnify tool can be used to erase very small or irregular
areas by making the foreground pen color the same as the
background pen color and painting over the pixels which need
to be erased.
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The Erase Tool

Seven different options are available for erasing part or all of
an image from the screen. These options are Lasso, Rectangle
(the default), All, or any of four predefined eraser sizes
supplied for your convenience.

When the Lasso icon is selected, a region of any shape may be
erased by pressing the left mouse button down, dragging the
mouse around the region, and releasing the button. The lasso
will then finish the loop by connecting the last point to the first
point with a straight line and erase the area contained in the
lasso.

The All icon can be used to erase the entire painting surface.
A second way to erase the entire project is to hold down the Alt
key while selecting the Erase tool from the Main Tool Bar.
This is the most convenient way of erasing the screen, but you
will not be warned as with the All icon.

The Palette Tool

The Palette tool can be used to change any of the colors in the
Palette Bar. Upon selecting this tool, three sliders and a group
of icons will appear in the Control Panel.

Initially the three sliders will be set to the red, green and blue
components of the current foreground pen. Select any element
of the Palette Bar to change its color. To remix the color
currently selected, drag the sliders up and down with the
mouse or click below and above the sliders somewhere to move
the knobs by one color level increments.

Displayed above each slider is the level of color contributed by
that slider. It is a hexadecimal number which goes from 0 to 9
and from "a" to "f'. The numbers are provided to facilitate
easy duplication of colors. Also a group of shades of a given
color can be fashioned. A gray scale, for example is easily
done. A value of 0 for red would indicate that no red is mixed

in the current color. A value of "f" would specify all red.



ColorFont
Palettes

Color Ranges

Copy Color

Undo Palette
Changes

To save a specific color palette on disk, use the Save As Project
menu item on a small painting. Or use the Cut tool's Save
icon on a cut. The best process is to create a very small cut and
save the result to the disk with the Cut tool's Save icon. When
this cut is loaded with the Open item of the Project menu, the
current palette will be changed to the one that is stored in the
file. The image of the painting will be affected according to
the size of the cut.

There are four control icons associated with the Palette. The
first one is used to load the palette of a ColorFont. The second
is used to make a smooth tonal scale. The third is used to copy
colors in the Palette Bar. And the fourth is an undo function.

To load the palette that comes with a ColorFont, first use the
Fonts tool to load the ColorFont. Once the ColorFont is loaded,
select the Palette tool and click on the Load ColorFont Palette
icon which is located in the upper left corner of the Control
Panel.

To make a smooth tonal range, select the end points of the
range with the foreground and background pens, then click on
the Range icon which is located in the upper right corner of the
Control Panel. Immediately the colors between those selected
by the foreground and background pens will be replaced with a
smooth scale of in between colors. This feature is useful when
setting up a palette for smooth shading and smooth tone
airbrush painting.

[NOTE: To change the foreground pen color, click on the desired color

of the Palette Bar. To change the background pen color, click on the
desired color while holding down a Shift key. ’

The Copy Color icon (which is just below the ColorFont Palette
icon) will cause the current background pen color to be copied
into the palette box currently in use as the foreground pen.

The Undo icon allows free experimentation with a palette.
Clicking on this icon will restore the palette to what it was
when the Palette tool was activated. However, once you leave
the Palette tool by requesting another tool all palette changes
become permanent.
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The Print Tool

The Print tool provides control over how the painting in the
computer will appear on the printed page. The three basic types
of printing are small regions for test settings, screen format
prints, and full-page prints.

To start the printing process, click on the Printer icon in the
Control Panel. Fusion Paint will verify that it is really
alright to commence printing. This allows the opportunity to
check the printer's paper alignment and settings. A few
seconds after pressing the YES button, the printing will begin.

A cancel printing feature has been built-in to save time for
those situations in which you do not want the printing to be
completed. To cancel the printing, click inside the window
which displays the "Stop Printing..." message. How quickly
the printer stops depends on several factors. But the only one
that can be readily changed is to turn the printer OFF LINE.
This usually sends a message back to the Amiga which will
cause the printer routine to realize that it has been told to stop.
If the printer has a large internal buffer, there might be
additional delays before the printer stops. Small printouts
may never get canceled because of the buffer effect.

There are several ways to specify the area to be printed by the
Print tool. With Fusion Paint, any rectangular portion of the
project may be printed. When the Print tool is first selected,
the area to be printed is set to be the currently displayed
window. This can be modified by boxing (rubberbanding) an
area in the painting. Once the area has been defined, select
the Printer icon to begin the output.

While boxing the area to be printed, the painting can also be
scrolled. Thus the printed region can be as small as a single
pixel to as large as the entire page. There is also a special icon
to direct the Print tool to print the entire page. It is the All icon.
If enough memory is available, a page size which would fill a
page on your printer can be defined.



Auto Sized Mode

F1 Key

F2 Key

F3 Key

F8 Key

The icon just below the Boxes icon is the Auto Size icon. In the
AutoSize mode, the printer driver will attempt to keep the
aspect ratio of the painting the same on the printed page as it is
on the display screen. This means that circles on the screen
will also be circular on the printer.

Keyboard Equivalents

Fusion Paint support keyboard equivalents for the Main tools
and their Control Panels. These keyboard equivalents are
explained in the following sections.

The Function Keys

Pressing the F1 key puts Fusion Paint in the "Pick Color"
mode so a new pen color may be directly selected from the
picture. To do this, hit the F1 function key and click on a pixel
of the desired color with the left button of the mouse. If a Shift
key is held down while clicking with the mouse, the picked
color will be placed in the background pen instead. It is
possible to use the real time Zoom Lens to select the actual pixel
to copy the color from by depressing the right mouse (menu)
button before selecting the desired color. The Zoom Lens is a
helpful aid when picking colors from very small areas (even
a single pixel) on the screen

The F2 key is used to single step through a color cycling
display. This is the keyboard equivalent for the Single Step
menu item in the Modes menu.

The F3 key is used to reset the palette when a display is paused
in a color cycled state. This can happen when the F2 key has
been pressed to single step through a color cycling effect. It is
best to reset the palette with the F3 key because some operations
(accessing the Palette tool) will make the palette changes
permanent.

The F8 key performs the same function as the Color Brush

item in the Modes menu. It is used to change the color of the
current brush to that of foreground pen.
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Fusion Paint

Pressing the F9 key once will remove the mouse pointer from
the display. Pressing the F9 key a second time will turn the
mouse pointer back on. This is useful when doing fine detail
work where the mouse pointer is obscuring the work area. It
can also be used with brushes. Another use for this is to hide
the mouse pointer when showing a picture for recording on
film or video tape.

Pressing the F10 key once will remove the icons from the
screen. Pressing the F10 function key a second time will
restore the icons. This is a display mode only, intended for
use when displaying a picture for recording it on film or video
tape. As this mode pauses the editing process, any
rubberbanding or brushing that is in progress will still be
visible on the screen when the icons have been turned off.

Miscellaneous Keys

Usually it is not desirable to flush the entire undo buffer. For
this reason, the right-Amiga and "4" key combination can be
used to flush the oldest one fourth of the buffer.

At times it is desirable to flush only a small portion of the undo
buffer. For this reason, the right-Amiga and "8" key
combination can be used to flush the oldest one eighth of the
buffer.

The right-Amiga and "O" key combination is equivalent to
choosing the Open-Picture submenu item in the Project menu.
The right-Amiga and "Q" key combination is equivalent to
choosing the Save Quick-Picture submenu item in the Project
menu. The right-Amiga and "S" key combination is
equivalent to choosing the Save As-Picture submenu item in
the Project menu.

The Tab key is used to toggle color cycling on or off. If the Tab
key is pressed while a Shift key is being held down, the Set
Cycles window will be activated.

The Return key scrolls the page so the screen is centered on it.
It can also be used to scroll quickly to the center of a large
painting.



Cursor Keys

Esc and Help
Keys

Ctrlleft-
Shift/left-Alt and
Help or Esc Keys

Ctrl, Shift, and
Alt Keys

The Cursor keys may be used to scroll the page in any
direction. Like the Scroll Arrow icons, the effect of these
arrows is modified by holding down either the Ctrl or Shift key
while pressing the Cursor key. The Shift key increases the
speed of scrolling by a factor of four, and the Ctrl key causes
the page to scroll the the end of the page in the chosen direction.
By using the Return key before Ctrl and a Cursor key, it is
possible to get to nine regions on a page precisely and very
quickly.

These keys will cause one Undo to occur each time either is
pressed. The Shift keys modify these keys and cause reverse
undoing to take place.

The special combination Ctrl, left-Shift, left-Alt key while
pressing either the Help of Esc key will execute the Flush-All
submenu item in the Undo menu. This frees the memory
consumed by the undo buffer. Any undos which are flushed in
this manner are gone. That is, the previous operation cannot
be redone.

Usually it is not desirable to flush the entire undo buffer. For
this reason, the right-Amiga and "8" key combination can be
used to flush one eighth of the undo buffer, and the right-
Amiga and "S" key combination can be used to flush one
fourth of the buffer.

The usual designation is that the Shift keys are used to
indicate that an object (for example a circle or a line) is to be
dragged about the page. The Ctrl and Alt keys normally act as
a modifier to adjust some other parameter of a rubberbanded
object. An example of this is the Double Control Point Curve
option in the Circles tool which uses the Ctrl and Alt keys to
select the control point to be adjusted.

Two additional regions of the keyboard are used to duplicate
the use of the mouse to select the various tools along the right of
the screen and the various extra control icons along the right
edge of the screen. The first of these regions is the two vertical
rows of keys that read 1QAZ and 2WSX and then the two
vertical rows of keys that read EDC and RFV (U.S. keyboard).
These keys are used to duplicate the Main Tool Bar icons.
These rows of keys have a one-to-one correspondence with the
Main Tool Bar icons.
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Fusion Paint
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When a particular tool is selected (for example the Circles
tool), a Control Panel will be displayed on the right-hand side
of the screen.

The pad is set up as one column of two keys (on the Amiga 500
and 2000) which are arranged in the following fashion:
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TROUBLESHOOTING
Starting

Problem 1: For the current session, Fusion Paint previously
ran fine, but now will not start.

Solution: Ask for a smaller screen size or try requesting fewer
colors. Close other programs that are running and all
unnecessary windows.

Problem 2: A 320x200 screen and page size in two colors would
not load after closing all unused windows and releasing all
possible memory.

Solution: Reboot the system from the current Workbench disk
and try again,or reboot with a new copy of Workbench.

Problem 3: Fusion Paint starts when the Amiga is booted from
a new copy of the original Workbench disk, but does not
execute properly when the Amiga is booted from the working
copy of the Workbench disk.

Solution: Make certain that the libs directory contains these
files:

diskfont.library
icon.library
mathtrans.library
info.library
arp.library

all printer files

Problem 4: When Fusion Paint is started, the message "Could
not allocate the Edit page, not enough memory" is displayed.
Solution: Make more memory available by closing open

windows and programs. Request a smaller page size, smaller
screen size, and fewer colors.
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Printing

Problem 1: It will not print.

Solution: Check the printer cable. Make sure you are using the
correct printer driver and the latest version. Try booting from
the Fusion Paint disk. It may be that the page size is too big to

print. Use the box mode of the Print tool to box a small area. If
this prints, select a smaller page size for printing.

Problem 2: The message "Cannot open printer” is displayed
upon sending an image to be printed.

Solution: Select a printer driver on the Workbench disk.

Memory

Problem 1: When pull-down menus are selected, nothing
happens.

Solution: Try the keyboard.equivalent for Flushing Undos to
restore memory.

Problem 2: When using the Airbrush or Brush tools, the screen
starts flashing wildly.

Solution: Restore memory as described above.
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THE BYZANTINE CRUSADER --
MAY 25TH, 1938

Holy Grail Search To Continue
By Bob Ellis

Dr. Henry Jones was back in hiding last night after speaking
to this reporter about his continued search for the Holy Grail
treasures. New information is believed to have been found by
Dr. Jones on his trip to Europe.

There was a deepening mystery when Dr. Jones vanished
from his home recently after many years of research into the
real location of the sacred treasure. Many believed that he had
travelled to the Nile Delta but this paper is proud to reveal that
he has found further evidence in Central Europe. While he
was not willing to give detailed information, we believe that
the Dr. has found the whereabouts of the famous shield said to
contain the vital directions needed to find the Holy Grail.

What, I asked Dr. Jones, was the Holy Grail? " The chalice
used by Christ during the Last Supper" he replied, "The cup
that caught his blood at the Crucifixion and was intrusted to
Joseph of Arimathaea. It disappeared and was lost for a
thousand years before being found again by three knights of
the First Crusade, three brothers to be exact.”

"One hundred and fifty years after finding the grail, two of
the brothers began the journey home but only one of them made
it back. Before dying of extreme old age, the knight told his
story to a Franciscan friar. He did not reveal the location of
the Holy Grail, but instead promised the friar that two
‘markers' had been left to mark the way.

"The first of these markers has recently been discovered,
incomplete, in the mountain regions north of Ankara and is
currently in the hands of Mr. Walter Donovan, a major
contributor to the Old World Museum."
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The second marker is thought to be buried with the second
brother, and it is this marker that Dr. Jones is seeking at this
time.

Little mention is made of the third brother by most historians
but it is believed by many of them that he remained behind to
become the keeper of the grail. If this is so, then what has
happened to him after all these years? Is he still alive ?

Dr Jones, his white beard showing a faint smile on his lips,
declined to comment. With that smile our interview ended
and he departed.

Your reporter watched him leave, finished making notes of the
conversation, summoned a gondola, and returned to his hotel
to write this report.

Grail
by Marcus Brody

The word grail is derived from 'gradule’, which means step
by step, degree by degree.

There are six degrees or levels of awareness in the grail quest
and each one is represented by an animal. The raven was the
symbol of the first degree and represented the messenger of the
grail.

The peacock signified the second degree and symbolized the
search for immortality.

The sign for the third degree was the swan to show that the
person who searched for the grail sang a swan song to selfish
and indulgent ways.

The fourth degree was the pelican, a bird willing to nurture its
young by wounding its own breast.

The lion, its leadership and conquest, defined the fifth degree.
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The sixth and highest level was represented by the eagle and
was achieved at the end of the quest to show knowledge and
power gained.
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PROGRAM INSTRUCTIONS
Loading Instructions

Turn on the computer and wait for the workbench prompt by the
computer. Ensure that the disk is 'write protected' and insert
into disk drive.

Game Play

Indiana Jones and the Last Crusade is an exciting multilevel
game in which you control Indy in his search for various
artifacts. There is an important artifact on each level. The
objective of the game is to fight your way through each level
and collect the artifacts. Once the artifact is collected, then
you need to fight your way to the end of the level.

Each level presents a different challenge and task. On level 1
you need to collect the Cross of Coronado but remember to
collect the torches or it will get dark and difficult to see your
way around the caves. Once you have the Cross you need to
escape over the top of the train.

Level 2 takes you deep within the catacombs. When the
catacombs were built, secret archways were constructed to
hinder false searchers. Presented with 6 arches, the true
searcher finds the correct arch and continues on his search.
The false searcher, unable to choose the right arch, is doomed
to wander the catacombs in vain, unable to find the Crusader's
Shield that lies there. When beginning this level you will see
the arches, and above each arch is a coded hieroglyphic. These
change daily and the date is shown above the arches. To find
the correct arch look up the date on the grid shown on the last
page of the Byzantine Crusader and enter through the arch that
matches the code you find. Once you have found the shield you
need to scale the castle wall, but beware of the lightning.

Level 3 and the game moves onto the airship. Search for the
Grail Diary that Indy's father has lost here. Be careful to pick
up the passes as you move. They are made of flimsy paper and
fall apart after a short time. If Indy does not have a pass the
alarm will be raised, making your task more difficult.
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And finally to Level 4. Dr. Jones Sr. has been shot and his
only hope is that Indy can get to the Holy Grail in time. With
dad's heart gradually turning to stone, you must guide Indy
quickly, but safely past the traps set by the Crusade Knights.
Time is your enemy and only the brave will make it in time.

Gameplay Controls

If you have a joystick connect it into the second Port.

F9/F10 will pause/Unpause the game.
Shift/ESC will abort the current game.
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OVERVIEW

F/A-18 Interceptor tests your air combat ability as you fly a
super-modern jet fighter against destruction-seeking
intruders. The action unfolds in a realistic flight
environment; you skim over the Bay, soar above the San
Francisco Peninsula, and perform maneuvers above the
Pacific Ocean. You look out from the cockpit of a Navy F/A-18
Hornet or an Air Force F-16 Fighting Falcon.

Read the "Getting Started" section to begin play, and study the
"Aircraft Reference" section to become familiar with the
joystick and keyboard controls for F/A-18 Interceptor. The
cockpit and controls are the same for both the F-16 and F/A-18.
After you've seen the demonstration flight, and have flown in
free flight, you practice the training maneuvers vital to
successful combat. You'll qualify for active duty, practice
selected combat missions, and then fly in actual combat
against the intruders.
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GETTING STARTED

You can play Interceptor on an Amiga 500, 1000, or 2000. Before
you begin, write-protect your disk, then make a playing copy of
the disk (refer to your Amiga User's Manual for instructions
on formatting blank diskettes and copying diskettes). You

can play Interceptor using the keyboard or joystick.

Note to new Amiga owners: F/A-18 Interceptor requires at
least 512K bytes of memory (if your computer has 512K bytes,
you should disconnect the external drive to receive improved
sound). It's recommended that you have a color RGB monitor
and one megabyte of memory to maximize sound capabilities,
as well as to view the Demonstration Flight in full. To get
started:

1. Turn on your computer and monitor.
2. Plug your mouse into Port 1, and your joystick into Port 2.

3. Insert your playing copy. If you have an Amiga 1000, use
KickStart 1.2 or 1.3, then insert your playing copy when
the on-screen request for the WorkBench appears. Move
the pointer to the Program Disk Icon, double-click the
mouse button, then double-click on the Interceptor icon at
the center of the screen.

4. The title screen and credits appears; when prompted, enter
a call-sign to enlist in a full Tour of Duty. Then press
Return (see note below).

5. When the Mission Selection screen appears, press the
number of the option that you want to begin to play.
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Note: When you write-enable your disk, "R" for Rookie appears as
the current call-sign. The Rookie is a pilot who has successfully
completed the first three F/A-18 Interceptor missions; using the "R"
call-sign thus lets you select from a wider variety of missions right
away. If you wish to use your own call-sign (thus permanently
erasing the Rookie), you must select 8 ('Your Current Flight Log’),
then reset the log by pressing Shift + 2. Now press 1 to update the log to
disk. A message appears requesting you to enter your own call-sign.
Or, you may remove the program disk and insert a blank, initialized
disk in DFO:. A message appears asking you to enter a call-sign.
You may opt not to enlist for a Tour of Duty. However, you must still
pass Qualification in order to fly combat missions.

F/A-18 Interceptor

How to Use the F/A-18 Flight Computer

To play F/A-18 Interceptor, you need to enter a security
countercode after you select any of the Flight options (see
"Flight"). At the on-screen prompt, you'll use your F/A-18
Flight Computer to line up the 4 letters and/or numbers, then
type in the appropriate code visible in the window above the last
letter or number.

1. The first letter or number is for the innermost (smallest)
dial on the wheel. Find that character.

2. Find the second character on the middle wheel, and line it
up directly over the first.

3. Find the third number on the large, outer wheel. Line it up
with the first two characters.

4. Now look on the innermost wheel to find the fourth
character (a window is placed directly above each). Type
in the numerical code visible in the window above the
fourth character, and press Return.

5. You should receive confirmation to proceed with the
mission. If you enter the incorrect countercode, you are
given two more chances to clear security before the
program asks you to re-boot.




Note: Use care when selecting characters on the Flight Computer; an
"8"can look like a "B", or an "0" can resemble a "D". To practice
using the F/A-18 Interceptor Flight Computer, find the number for the
combination 9E5F. You're on the right track if the answer you come
up with is 057247, See Flight Computer illustration.
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F1-F10

AIRCRAFT REFERENCE

When you take to the air, you fly one of two intercept aircraft -
either the General Dynamics F-16 Fighting Falcon or the
McDonnell Douglas/Northrop F/A-18 Hornet. In your capable
hands, the Falcon and the Hornet are both weapon and shield.
Please refer to Appendix A-Aircraft Specifications, for more
information on both aircraft.

Joystick Control

You control your plane in flight by using the keyboard, or a
joystick. Take control of the joystick when you plane is
taxiing down the runway during takeoff. Once you have
achieved takeoff speed of about 200 knots, pull back on the
Jjoystick and take to tne air. In flight, move the joystick in the
direction that you want your aircraft to fly. The joystick's fire
button fires the selected weapon against the selected target, and
triggers the instructor's next maneuver in Training:
Missions.

Aircraft Controls

Familiarity with the cockpit controls of both the F-16 Falcon
and the F/A-18 Hornet is important to the F/A-18 Interceptor
pilot. Prominent features of the cockpit are the HUD (heads-
up-display) system, the radar and weapons systems, and the
fuel, altitude and air speed indicators. The HUD, which
appears on the canopy above the control panel, includes a
target indicator, missile-aiming reticle, gun boresight line,
weapon select indicator, target-in-range, target lock-on, and a
G-meter (load measurement). Refer to the HUD illustrations
to familiarize yourself with these features.

Note: Refer to the illustrations of the cockpit control panel and the
keyboard when reviewing this list of controls:

Thrust. Controls throttle in 10% increments.

Note: Pressing F1 twice shuts down engine if you are at settings above
10%. Pressing F10 turns on the afterburner if you are at 100% throttle.
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Thrust. Increases throttle by one step.
Thrust. Reduces throttle by one step.

Brakes. Puts on speed brakes or ground brakes (depending on
your location when you apply them). The "Brakes" indicator
on left side of control panel lights up when you put the brakes
on.

Rudder Control. Left Rudder, turns left ("yaws").
Rudder Control. Right Rudder, turns right ("yaws").

Aircraft movement. The up arrow pitches the nose down, the
down arrow pitches the nose up, the left arrow rolls it left, and
the right arrow rolls it right.

Gear. Raises or lowers the landing gear.

Arrestor Hook. Extends the arrestor hook on F/A-18 for
carrier landings

HUD. Turns Heads-Up Display on/off. All displays, except
that for a selected weapon, disappear when you deactivate the
HUD. These return when you re-select it.

ECM Jammer. Turns ECM (Electronic CounterMeasures)
on/off. "ECM" is on the right side of the panel and is
highlighted when selected.

Chaff. Dispenses rapid-bloom chaff to jam an enemy
aircraft's electronic surveillance system, as well as radar-

homing missiles.

Flare. Dispenses an IR flare to draw IR guided missile away
from your craft.

Map. Displays the map of airspace and your location on the
HSI (Horizontal Situation Indicator).

Range. Controls the radar resolution (2, 10 or 40 miles)



T Target Select Selects the radar contact as a target. Toggle
through the available targets by pressing T repeatedly.

Return Weapon Select. Press repeatedly to toggle through the
available weapons. The selected weapon is highlighted by a
red bar in the weapons window on the control panel.

Space bar Trigger. Fires active weapon at the selected target.

Shift + F Dispense Rescue Pods. Releases rescue pods in some
missions.

Shift E Eject. Ejects you from a doomed aircraft.
Simulation Controls

P Pause. Pauses the game; press P again to restart the action.

Esc Reset Mission. Returns you to the beginning of the current
mission.

Shift + Esc Exit Current Mission. Returns you to Mission Selection
screen.
View Controls

Keypad Enter Switches viewing mode from first-person perspective, inside

the cockpit, to third-person perspective, outside the cockpit;
press Enter again to re-enter the cockpit. Press Enter to skip
the "zoom down" that follows your selection of any of the
scenarios; you'll go straight to the cockpit.

Shift + Enter Takes you to the control tower nearest your starting location.

[1] Zoom. Left bracket zooms out, right bracket zooms in.

The following keys, on the numeric keypad, function when
your view is from inside the plane:

4 Turns your head to the left.
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Turns your head to the right.
Locks your head in present position (see note below).

Turns your head around for backward viewing (checks your
” 6 " ) .

Straight-down view.
Straight-up view.

Returns you to forward view (shortcut).

Note: The program automatically returns you to the forward view
after 4 seconds. To prevent this, press 5 (see above) to retain the pilot

viewing mode that you have selected.

When you press Enter, the View Mode numeric keypad
remains operative. However, the view each number gives is
the position of the viewer outside the aircraft. Scroll through
the numbers on the keypad to view your plane in flight from
the different possible angles, then press Enter again to return
to the cockpit view. In addition to the 7 keys mentioned above,
the 3 and 9 keys are operative when you're viewing the plane
from the outside views (the 5 key now shows you a view of the
aircraft from directly above). In addition, the decimal point
gives you a beneath-the-plane view.

ECM (Electronic CounterMeasures)

You can use electronic countermeasures to foul the enemy's
radar, avoid detection and deflect an impending attack. ECM
has both an active form, like jamming the enemy's radar
electronically, and a passive form, like dropping chaff,
composed of small lengths of wire or foil. Chaff acts as a
signal decoy, confusing the tracker's radar - even causing
missile guidance on the wrong target. When a pilot faces
impending attack, he will often employ ECM and perform an
evasive maneuver simultaneously.
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Both the F-16A Falcon and the F/A-18 Hornet are fitted with
standard ECM pods. There is an ECM indicator on the right
side of your cockpit panel. It is highlighted in yellow when
your ECM pod is active. Using ECM reduces the range and
effectiveness of enemy missiles, but also provides a beacon to
your current position.

Available Weapons

Each aircraft boasts medium and short-range missiles, plus a
short-range cannon. The AIM-120A AMRAAM is the
medium-range missile on each aircraft; it is a highly
accurate "fire-and-forget’ weapon. The AMRAAM has an
effective range of over 30 miles; its guidance system keeps it
on a strapdown, inertial course until it approaches the target.
Then the AMRAAN activates a small active seeker in its nose
as it hones in on the target.

The short-range missile available to the F/A-18 Interceptor
pilot is the AIM-9L Sidewinder anti-aircraft missile. The
Sidewinder has a range of 11 miles, and reaches a speed of
Mach 3. A pilot maneuvering at 6g can still release a
Sidewinder towards its target; the Sidewinder can be released
when the attack craft is as close as 1,000 feet. The AIM-9
performs best when it is launched from astern at a glowing
afterburner, but its "all-angle" capability allows launch at
head-on targets as well.

The close-range cannon is the GE-M61. This is a 20mm
cannon that fires 570 rounds at 6,000 rounds per minute. In the
modern era, a close-range gun is most valuable in the midst of
a close-quarters dogfight.
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FLIGHT

Now that you've completed your brief check-out each aircraft,
you're ready to solo. Your departure point is always the
Mission Selection screen, where you choose the flight option
that's right for you. Select Demonstration Flight and become
familiar with the basic mechanics of flight from a
passenger's point of view - and some of the key landmarks of
the San Francisco Bay Area.

Select Free Flight a few times if you are a beginner to get the
feel of the airplanes, then select Training: Demo of
Maneuvers, to get acquainted with the basic combat
maneuvers. To practice the maneuvers behind an expert
instructor flying an F-16, select Training: Practice
Maneuvers, and go through the maneuvers (descriptions of
each found in Training:Practice Maneuvers). Select
Qualification to qualify for combat: now, go on to Next Active
Advance Mission, where you are dispatched on active status to
face one of 6 missions. As you complete them, you can relive
glories by selecting a previously completed mission in
Selectable Missions.

Demonstration Flight

After you select the Demonstration Flight (enter 1 at the
Mission Selection screen), you zoom onto the Carrier
Enterprise (CVN65). You watch as the Navy's workhorse
takes off from the carrier deck, with its afterburners alight.
When you select the Demo, you cannot take control of the
plane. The Demo gives you a brief taste of flight, then lands at
Alameda Naval Air Station. The Demo is self-repeating; to
exit to Mission Selection, press Shift + Esc. When you're ready
to take control of the aircraft, go on to Free Flight.
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Cockpit Control Panel
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Restart mission
Range select
Target select
Throttle Control
Pause

Zoom in-out

Brakes

8) View direction select
9) Arrestor hook

10) Chaff

11) Flare

12) Landing Gear

13) Fire selected weapon
14) Toggle H.U.D.

15) Map .

16) ECM Jammer

17) Rudder Control

18) Weapon select

19) Control stick

20) Point-of-view select
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4)
5)
6)
7
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Shift-E
Shift-Esc
Shift-Enter
Shift-F

Eject

Main menu
Control tower
Rescue Pod
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1) Compass

2) Target designator

3) Range marker

4) Aiming Reticle

5) Airspeed

6) "G" Loading

7) Weapon selected & number remaining
8) Missile seeker locked

9) Missile seeker searching
10) Wings

11) Altitude

12) Target closing velocity
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F-16

1) Compass

2) "G" Loading

3) Range marker

4) Aiming reticle

5) Airspeed

6) Target designator

7) Weapon selected & number remaining
8) Missile seeker locked

9) Missile seeker searching
10) Wings

11) Altitude

12) Target closing velocity

Free Flight, No Enemy Confrontation

Free Flight, No Enemy Confrontation is the perfect opportunity
to become familiar with the skills of flight that build a combat
pilot's base of experience. Once you select Free Flight, you
enter the security countercode (see the instructions in the
"Getting Started" section of this manual) and then select your
standing location, choosing between San Francisco
International (1), Alameda Naval Air Station (2), Moffett
Field Naval Air Station (3), and an Aircraft Carrier off the
coast of San Francisco (4). You choose to fly either the F/A-18
Hornet or the F-16 Falcon (if you select the carrier as your
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starting location, you are assigned an F/A-18 automatically).
Watch as the view zooms in to your aircraft in takeoff position
then check your control panel and verify that all systems are
"go". To take off, just press F10 to increase your throttle to
"military power". Once your airspeed reaches 200 Knots, pull
back on the joystick to lift off.

In Free Flight, you face no enemies, and have no aerial
targets to sight on. However, you can explore the possibilities
of flight, practice takeoffs, and familiarize yourself with the
control systems and flight characteristics of your aircraft.
Free Flight also lets you in on the sounds of flight - the roar of
takeoff as you accelerate, the whine of your landing gear when
raised, the kick of supersonic power as you light the
afterburners.

Note: If you should crash in any of the F/A-18 Interceptor missions,
you are returned to your starting position, in position to take off
again. However, if you are enrolled in a Tour of Duty, crashing
means that you won't gain mission completion credit in your flight
log (see Your Current Flight Log).

F/A-18 Interceptor

Training - emo or ivianeuvers

In Training: Demo of Maneuvers, you ride as a passenger, as
a flight instructor performs a sequence of basic flight
maneuvers. After you select the Training Demo from the
Mission Selection screen, you'll be prompted to enter a
security countercode. Then you're airborne, ready to watch the
first of 7 maneuvers. The pilot flies at 80% thrust throughout
the Demo; he may climb to altitudes above 14,000 feet, and fly
as fast as 650 knots.

As a passenger, you have no control of the aircraft. However,
to skip any maneuver, or to interrupt a maneuver in progress
and select the next in sequence, press Return (you may press
Return more than once if you wish to jump forward several
maneuvers). Once the sequence of maneuvers is complete (see
Training: Practice Maneuvers for a complete list of the
maneuvers), it will repeat automatically until you exit the
Demo. Take advantage of the Training Demo; it gives you a
leg up when you fly the maneuvers yourself in




Aileron Roll

Training:Practice Maneuvers. To exit and return to the
Mission Selection screen, press Shift + Esc.

Training - Practice Maneuvers

In Training: Practice Maneuvers, the maneuvers are the
same as those in Training: Demo of Maneuvers, and you
perform them in the same order. Once you select Training:
Practice Maneuvers, enter the security countercode, then read
the on-screen instructions. Now, you're lined up on the
runway, behind the instructor's plane; he'll wait for you to
begin his takeoff. Accelerate to 80% thrust; when you reach 200
kts, take to the air. Try to stay in sight of the instructor as he
climbs into position for the first maneuver. Follow the
instructor, and perform each maneuvers in sequence as he
does. If you lose the instructor once he starts to perform the
maneuvers, you can reposition yourself behind his aircraft by
pressing Return (once you're repositioned, make sure you stay
within range of the instructor without overtaking him).

Use your experience in Training: Demo of Maneuvers, and
follow the instructor as he loops or rolls, breaks or flies
inverted. If a particular maneuver is too difficult, you can
always trigger the next maneuver automatically. Make sure
you're lined up in sight of the lead place, then press the
joystick button when the instruction to trigger appears at the
bottom of the cockpit panel. The instructor executes the
maneuver, and you try to keep up. To skip a maneuver, press
Return; to leave a smoke trail behind the instructor's plane,
press S. Just as in Training:Demo of Maneuvers, the
maneuvers repeat automatically until you exit. Press Shift +
Esc. to return to Mission Selection.

What follows are detailed descriptions of the 7 maneuvers you
practice in Training:

To perform an aileron roll, push the stick to one side. The
plane rolls around, and its nose describes a circle on the
horizon, in combat, use rolls to position yourself to "lift"
through climbs, dives and turns.
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Break Turn

Inside Loop

Split-S

Vertical Half-

Loop

Barrel Roll

Inverted Flight

Use the Break Turn when the attacker is first seen
approaching, while you're in the enemy's "cone of
vulnerability.” To execute this maneuver, break hard in the
direction of the attack, fly with your wing pointed at the
ground, then right yourself. You want to generate "angle-off"
and ruin the aggressors angle, making him overshoot.

In an Inside Loop, you pull up quickly and go all the way over.
Your head faces the center of the loop, while you pull positive
G's. It's a bit like an aerial backward somersault. Perform
an inside loop to trade positions with an opponent who is near.

In the Split-S maneuver, the defender rolls inverted and then
dives away vertically, pulling out in the opposite direction
from his opponent. The idea is to force the attacker to
overshoot, positioning yourself for a reversal while destroying
the opponent's angle of attack.

In a Vertical Half-Loop, you pull back on the stick, get to the top
of the loop, then fly horizontally in inverted flight. Now roll
your plane upright. Also known as an Immelman, the half-
loop allows you to gain altitude and reverse directions.

In the Barrel Roll, the defender first breaks, then rolls in the
opposite direction of the break. The Barrel Roll involves loss
of much speed; it works best when the attacker is in a high
angle-off, high overtake situation. If you execute this
maneuver properly, the opponent should overfly you.

Inverted Flight is a basic part of several aerial maneuvers. To
accomplish it, pull the stick back until you're upside down,
maintain your direction, then fly inverted. Try to maintain
level fight if you can.
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Qualification

When you've completed your training and orientation, choose
Qualification at the Mission Selection screen. You quickly
hear the roar of the F/A-18's powerful engines, and look out
from the Hornet's cockpit onto the Enterprise's deck and the
ocean beyond. After entering the security code, read the on-
screen instructions for qualification.



In Qualification, you must take off successfully from the
carrier's deck, fly around, then return to land safely on the
carrier deck. You should be prepared for potential opponents in
the Pacific skies; your enemies are indifferent to your
mission, and will harass you with impunity. Deal with bogeys
if they appear, then find your way back to the carrier. Get a
bearing on the ship, reduce your speed to 175 knots, drop your
altitude, and bear down on the flight deck. Put on your brakes,
lower your landing gear and arrestor hook, then hit the wires
to come to a full halt.

Once you pass Qualification, you are eligible for active duty (a
message appears on-screen confirming your advancement to
active combat status).

Escape repositions you on the carrier deck; Shift+Esc.sends
you back to Mission Selection.

Next Active Advanced Mission

When you select Next Active Advanced Mission, you take on
the challenge of several combat missions against the
intruders. Once you select Next Active Advance Mission and
enter you security countercode, you'll fly the first of several
missions. Each has a specific task for you to execute (see the
descriptions of 4 of the missions below). To succeed in Next
Active Advanced Mission, you must be versed in all phases of
active combat - flying the aircraft, detecting the enemy while
avoiding detection through electronic and visual measures,
closing in for an attack, selecting and readying your weapon
systems, attempting kills, and then maneuvering to
disengage from combat.

Note: The warning lights in the upper-right corner of the cockpit
control panel flash these different colors when the following
situations arise:

1) A friendly plane in the area is green
2) An enemy in the area is red

3) A stall warning is red
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4) An RH missile fired at you is white
5) An IR missile fired at you is white.

In addition, an explanatory message appears at the bottom of
the control panel for each "event".

Visual Confirmation

In this first combat mission, you take off from San Francisco
International in an F-16 Falcon or an F/A-18 Hornet. Your
assignment is to find and identify an aircraft (it's somewhere
out there!), then return to SFO unscathed. The aircraft which
you must identify may be friend or foe. In Visual
Confirmation, you face some danger of attack. All your
weapons systems are operational, so arm your weapons if you
spot a bogey. Shoot only if fired upon. If you can avoid a melee,
you're better off. An on-screen message lets you know when
you've completed your assignment. Head for home, and put
your aircraft down in one piece.

F/A-18 Interceptor

Emergency Defense Operation

When you complete Visual Confirmation, you're ready to fly
Emergency Defense Operation. Select it, and you fly an F/A-
18 Hornet from the deck of the carrier anchored off the coast of
San Francisco. Your mission assignment is clear and
compelling: "We have hostile aircraft in your sector. Air
Force One currently on course to SFO." That means that the
Commander-in-Chief is unaware of the attempt to assassinate
him and fatally compromise U.S. security. In this prospective
mission, you must intercept and occupy the aggressor planes,
allowing the Air Force One pilot time to land safely at SFO (an
on-screen message informs you when the President's plane is
down). Scramble to the scene of the attack, deflect or destroy
the enemy, and return to the carrier to land. Emergency
Defense Operation is a combat pilot's challenge of the highest
magnitude - including the ability to gain attack position, out-
maneuver your opponent, and out-gun him if necessary.



Intercept Stolen Aircraft

Two F-16 Falcons from the U.S. Air Force have defected to the
enemy's side, and are aided in their escape attempt by a couple
of unidentified escorts. Your assignment is to take off from
the carrier, find the would-be defectors and their co-
conspirators, and deal with the enemy planes in the most
convincing manner possible. Fly in front of the would-be
Benedict Arnolds to inform them that the game is up. If they
agree to return home, escort them there; if they disobey your
signal to surrender, prevent their getaway at all costs.

Search and Hescue Uperation

In Search and Rescue Operation you try to find and rescue a
downed friendly pilot. Take off from the Carrier Enterprise
and find the lost pilot, using radar and your keen pilot's eyes.
Again, enemy aircraft seek to prevent the execution of your
mission. After you locate the downed flier, you should deploy
the rescue pod within his range. A message informs you if the
drop is successful. Once the downed pilot is safe, your job is
done - return to the carrier and safety.

Selectable Missions

Choose Selectable Missions after flying Next Active Advanced
Mission. You'll be able to select any of the missions that you
completed in Next Active Advanced Mission, plus one more.
Each time you complete a mission in Selectable Missions, you
are given a new scenario to select from the Selectable

Missions screen. As you take to the air in each mission, all of
your instrumentation and weapons are operational; your
aircraft is standing by, so strap on your G-suit and climb
aboard. Fly Selectable Missions to practice the combat
scenarios before returning to combat on active status.

Note: There are other selectable missions, which we won't describe
here. Once you have successfully completed an active mission, you
may repeat it. The second time around, though, you may have to
contend with a tougher array of opposing pilots.
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Your Current Flight Log

Your Current Flight Log lets you view your progress when you
enroll in a Tour of Duty (you must write-enable your disk
before enrolling). Select Your Current Flight Log from the
Mission Selection screen: your view a summary that includes
the following:

1) Total missions started

2) Missions successfully completed

3) Amount of weapons fired and hits achieved

4) Accumulated flight time

5) Total number of crashes - doesn't include ejections
6) Hits suffered from enemy missiles

After each mission that you complete, your flight log is
updated. To save the update onto your disk, press 1. Any
missions you've completed count to your credit; for example, if
you've completed the first two Selectable Missions, you can
begin the third whenever you like. As you fly more missions,
you will continue to update the Flight Log, keeping track of
your progress throughout play.

- If you wish to reset the Flight Log and keep statistics from
scratch, press Shift+2. This erases the current log and sets all
statistics at 0. When you reset the Flight Log, you erase credit
for any missions completed. Remember to enter a new call-
sign.

[Note: You'll need to re-qualify to fly missions.

To exit from the Flight Log back to Mission Selection, press
Esc.
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TIPS FROM A COMBAT
VETERAN

Learning the workings of today's modern fighters is a key
element of the pilot's art. He needs to know where all the
controls are by touch, but more than that, he needs to approach
his aircraft as the wonder of aerospace technology that it is.
Your F/A-18 Interceptor and F-16 aircraft are the best that the
Navy and Air Force can put in the air. They are the results of
thousands of hours of design and engineering, and are kept in
tip-top shape by careful ground crew maintenance. In your
hands, the F-16 and the F/A-18 turn into precise instruments,
and the trained pilot emerges as a surgeon of the sky.

The art of combat flying is a combination of skills.
Experience is any pilot's best teacher - there's no substitute for
long hours spent perfecting basic flight maneuvers, the
principles of attack, and successful disengagement. The
qualities that a top gun must have include courage,
determination, acceptance of danger, and a measured faith in
his ability to get the job done without fanfare. A flashy show-
off is guaranteed one of two outcomes - a quick trip to the
beyond, or lots of practice separating himself from the lines of
his flight chute after a dizzying fall to earth.

A solid pilot builds flight skills in stages, taking on the right
challenges at the right time - taking it smart, not easy. That
means graduated training, moving from Free Flight to
Training, on to Qualification, then Selectable Missions, and
finally Next Active Advanced Mission. He applies basic
principles like achieving surprise, detection, gaining a
superior attack position, closing, and using weapons in an
attack. A smart pilot builds a good variety of maneuvers into
his repertoire, practicing each until it is second nature.
Careful preparation helps instill a calm, winning attitude in
the most heated of aerial encounters.

Welcome to the combat pilot's fraternity!
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Dimensions

Weight
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Ordnance

Speed

Combat Radius

Ferry Range

APPENDIX A - AIRCRAFT
SPECIFICATIONS

The General Dynamics F-16 Fighting Falcon is a state-of-the-
art, lightweight, multi-role air-combat fighter with an
advanced ground attack capability. The F-16 is a single-seat
aircraft with a single vertical tail, mid-mounted tailerons
and wings, leading-edge flaps, and trailing-edge flaperons.

The F-16 has a single Pratt and Whitney F100-PW-100 engine
with 23,830 Ibs of thrust.

The aircraft has a wing span of 31 feet and a length of 47 feet.

16,794 lbs when empty, and 37,500 lbs at maximum take-off
weight.

The Fighting Falcon's primary navigation system is a
Singer-Kearfott SKN-2400 INS with a Standard ALQ-131 ECM
Pod.

Its radar capability includes an I/J-band pulse-doppler set,
with range scales of 2,10, or 40 miles. The Falcon's downlook
capability allows detection of fighter targets over 30 miles -
including treetop targets.

The F-16 can carry a weapon load of up to 20,450 lbs. With 2
short-range Sidewinder heat-seeking missiles boasting an 11
mile range, 4 medium-range AMRAAM missiles with a 30
mile range, and an internally-mounted GE M61 A-1 gun
capable of firing 500 rounds of armor-piercing projectiles at a
maximum range of 500 meters, the F-16 is a sleek and deadly
weapon of defense.

The Falcon can attain a maximum velocity of about 1350 mph
(Mach 2.05) at 40.000 feet; at sea level, the F-16 reaches a speed
of around 915 mph (Mach 1.2).

The Falcon's tactical combat radius with maximum internal
fuel is 340 miles.

The fighter's ferry range is 2415 miles.
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172 F/A-18 Interceptor

The combat pilot is assured a quiet ride and an exceptional
all-around cockpit view when he takes the Falcon out for a
ride. Control inputs are force-sensing sidestick controller
and pedal, both positioned for maximum effectiveness. The
speed and range of the F-16 Falcon guarantees top
performance in several areas of combat.

The carrier-based McDonnell Douglas/Northrop F/A-18
Hornet is a U.S. Navy workhorse, performing both fighter and
attack functions. Designed as a replacement for the timeless
F4 Phantom II and the versatile A7, Corsair, the F/A-18 has
filled a critical strategic need in the Navy's combat arsenal.

The Hornet is driven by two GE F404-6E 400 engines, each of
which generates 16,000 lbs of thrust.

It spans 37 1/2 ft. without missiles, and over 40 feet with
missiles.

The F/A-18 weighs 23,050 lbs empty, and 36,710 lbs when
loaded for a fighter mission.

Search and define, lock-on and multiple-pass capabilities.

There are 9 external weapon stations on the aircraft, plus 4
medium-range AMRAAM missiles, 2 short-range
Sidewinder missiles, and a GE M61 cannon (20mm) that fires
up to 570 rounds.

The F/A-18 can reach a maximum speed (clean) of 1190 mph,
or Mach 1.8, and will sustain a combat maneuver ceiling of
over 40,000 feet.

The Hornet's air-to-air combat radius (with no external fuel)
extends to 461 miles.
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ATTENTION

COMMANDS

GETTING STARTED

Turn on your monitor, then your computer. Insert the

KICKSTART disk(for Amiga 1000 owners) into the internal
drive. The AMIGA will read the system from this disk, then it

will require the WORKBENCH disk. Now you are in the
common sequence of all AMIGA models.

Insert the F40 disk into your disk drive (instead of the
WORKBENCH disk).

You must never remove the F40 disk from the drive while in

use.

The Ferrari is controlled by the joystick or the mouse.

Joystick commands will be interpreted as follows:

P accelerate

DOWN decelerate and brake
LEFT turn left

RIGHT turn right

FIRE BUTTON  shift up and down
Mouse commands:

The right button accelerates.

The left button decelerates and brakes.
The two buttons together shift up and down.

Keyboard Commands:

Left Arrow: turn left

Right Arrow: turn right

Up Arrow: accelerate

Down Arrow: decelerate and brake

The F2 key displays the road map.
The F3 key turns on and off the radar detector.
The F4 key selects the speed unit (MPH/Km/h).

GETTING STARTED
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The F5 key allows you to end the game if desired.
The F6 key displays the steering wheel.

When your speed doesn't correspond with the cornering
radius, a 360 degree spin can occur.

A 360 spin can be triggered by shifting down and cranking the
steering wheel at full speed.

You come out of a 360 spin by straightening the steering.

When the game ends, enter your name next to your score. You
do this by selecting the letters one by one with the cursor moved
by the mouse or the joystick. Press the FIRE button to store
each letter. Once your name is entered, move the cursor to the
END character and press the FIRE button. Your new score is
now stored on the disk.

If you want to skip the opening music, press the FIRE button as
soon as the music starts.



YOUR MISSION

THE STORY

You're at the wheel of the fabulous Ferrari F40 in a race
against time!

You'll go tearing through four states in search of the quickest
way to accomplish your mission. You will encounter
problems with policemen who don't appreciate the sight of a
Ferrari F40 crossing their state at 200 miles per hour.......

But, it's not that easy.......

You must plan your route carefully from the map of each state
displayed on screen. It will show highways you will speed on.
Beware, the shortest routes aren't always the easiest as the
sight and sound of a flashing light will soon make you
realize.

Your Ferrari features the latest radar, which assists you in
detecting police cars and road blocks. They have been set up to
stop you, therefore keep an eye on the highway junctions as you
may be forced to change your direction!

At the beginning of the game, your starting positions and the
first destination will be displayed on the map. You will have
to consult the map repeatedly for direction information.

When nearing a junction, your on board computer will
display the highway numbers and the direction arrows of the
impending road. The map represents the highways of four
states.

You can cut through fields, but watch out for telephone poles
and retaining posts!

The police will send cars and set up road blocks to stop you.
Avoid them by doing some off-roading or by sneaking through
barrier gaps.

At the beginning of each stage, the timer displays the time
available for this stage.
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As soon as you start your engine, the countdown starts. You
have to reach the tinish within the allocated time. If it reaches
zero, your Ferrari explodes!

SCORE AND
BONUS

Your score increases with the distance covered.

If you complete the stage within the allocated time, the bonus
will be added to your score.

Bonus are earned as follows:

20,000 points at the beginning of the first stage.

40,000 points at the beginning of the second stage.
60,000 points at the beginning of the third stage. Ete....

10,000 points each time you break through a police road
block.

The bonus decreases as soon as you start driving. The less

time you use to complete your mission, the more bonus you
could earn.
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